OpenLynx User’s Guide

The software described in this book is furnished under a licence agreement and may be used only in accordance with the terms of that agreement.

Copyright Notice

Micromass Ltd believes that the information in this publication is accurate. However the information is subject to change without notice and should not be construed as a contractual undertaking by Micromass Ltd. Despite the care that has been given to the preparation of this publication, Micromass Ltd accepts no responsibility for any loss or any other matter that may arise from any error or inaccuracy that may inadvertently have been included.

Copyright © 1993-2002 Micromass Ltd. All Rights Reserved.

No part of this publication may be copied without the express written permission of Micromass Ltd.

Trademarks

Micromass ® is a registered trademark of Micromass Limited (Reg. U.S. Pat. & Tm. Off.).

MassLynx and OpenLynx are registered trademarks of Micromass Ltd.

Windows is a trademark of Microsoft Corporation. Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies and are hereby acknowledged.
Table of Contents

OpenLynx User’s Guide ...................................................................................................................... i
OpenLynx Users Guide..................................................................................................................... ii
Copyright Notice............................................................................................................................... ii
Trademarks ........................................................................................................................................ iii
Table of Contents .............................................................................................................................. iii

Chapter 1 Introduction ........................................................................................................................ 1-1
Contents .............................................................................................................................................. 1-2
Figures .............................................................................................................................................. 1-2
Overview ........................................................................................................................................... 1-3
Assumptions ........................................................................................................................................ 1-3
The Life Cycle of a Sample .................................................................................................................... 1-4
Reprocessing Samples ......................................................................................................................... 1-4
OpenLynx Modes of Operation ........................................................................................................... 1-5
Open Access Walk Up Single Sample Loop ....................................................................................... 1-5
Open Access Walk Up Single Sample LC .......................................................................................... 1-5
Open Access Walk Up Micro Titre Plate Login (Loop) ....................................................................... 1-5
Open Access Walk Up Micro Titre Plate Login (LC) .......................................................................... 1-5
Initial Installation and Test .................................................................................................................. 1-5
Installing the MSPC software ............................................................................................................. 1-6
Setting Up the Network Connection .................................................................................................... 1-6
Installing the Login Software ............................................................................................................. 1-7
Installing the Browser Software .......................................................................................................... 1-8

Chapter 2 OpenLynx Setup .................................................................................................................. 2-1
Contents .............................................................................................................................................. 2-2
Figures .............................................................................................................................................. 2-3
Overview ........................................................................................................................................... 2-5
OpenLynx Setup Configuration Wizard .............................................................................................. 2-5
User Interface ..................................................................................................................................... 2-6
Selecting Tabs to Display ...................................................................................................................... 2-7
The OpenLynx Setup Toolbar ............................................................................................................. 2-8
Getting Started ................................................................................................................................ 2-9
Walk-up Page ..................................................................................................................................... 2-9
Input Fields .......................................................................................................................................... 2-11
Printing Page ....................................................................................................................................... 2-12
MS Data Page .................................................................................................................................... 2-13
DAD Data Page ................................................................................................................................... 2-14
Analog Data Page ................................................................................................................................. 2-16
Instrument Page .................................................................................................................................. 2-17
MS Process Page ................................................................................................................................. 2-19
Combine Parameters ........................................................................................................................... 2-20
Isotope Modelling ................................................................................................................................. 2-22
MaxEnt ................................................................................................................................................ 2-22
Mass Measure MS Data ....................................................................................................................... 2-23
AFAMM Parameters ............................................................................................................................. 2-24
Isotopic Cluster Analysis ...................................................................................................................... 2-25
Spectrum Test Page ............................................................................................................................. 2-27
Chromatogram Test Page ..................................................................................................................... 2-28
Quality Control Page ............................................................................................................................ 2-29
Quantify Page ...................................................................................................................................... 2-32
Library Page ....................................................................................................................................... 2-33
Select Library ..................................................................................................................................... 2-33
Search Library ..................................................................................................................................... 2-34
Build Library ....................................................................................................................................... 2-36
## Chapter 3 OpenLynx Browser .....................................................................................................................3-1

### Contents ........................................................................................................................................................3-2

- Figures......................................................................................................................................................3-3
- Overview..................................................................................................................................................3-5
  - Creating Report Files.........................................................................................................................3-5
  - The OpenLynx Browser Screen........................................................................................................3-5
  - The OpenLynx Browser Toolbar........................................................................................................3-6
- Getting Started ..........................................................................................................................................3-7
- Report Schemes.........................................................................................................................................3-8
- Report Scheme Settings.........................................................................................................................3-8
- Print Control Page..................................................................................................................................3-9
- Report Column Selection Pages..........................................................................................................3-10
  - Decimal Places Page.........................................................................................................................3-13
- View Options........................................................................................................................................3-13
  - Spectrum Page.................................................................................................................................3-13
  - Chromatogram Page..........................................................................................................................3-15
  - Default Plate Page.............................................................................................................................3-17
  - Colors Page.......................................................................................................................................3-18
  - Copy Control Page............................................................................................................................3-19
- Column Pages..........................................................................................................................................3-20
  - Fraction Display Page.......................................................................................................................3-21
  - Other Display Options.......................................................................................................................3-23
- Other Menu Options............................................................................................................................3-24
  - File Menu..........................................................................................................................................3-24
  - View Menu........................................................................................................................................3-25
  - Window Menu....................................................................................................................................3-26
- The Browser Panes.................................................................................................................................3-26
  - The Plate Pane..................................................................................................................................3-26
  - The Sample Description Pane.......................................................................................................3-27
  - The Fraction Collection Results Pane............................................................................................3-28
  - The Results Table Pane....................................................................................................................3-28
  - The Spectrum Pane...........................................................................................................................3-30
  - The Elemental Composition Results List / Library Search Results List Pane.................................3-31
  - The Elemental Composition Results List.......................................................................................3-31
  - The Library Search Results List.......................................................................................................3-32
  - The Chromatogram Pane..................................................................................................................3-32

## Chapter 4 OpenLynx Manager .....................................................................................................................4-1

### Contents ......................................................................................................................................................4-2

- Figures......................................................................................................................................................4-2
- Overview................................................................................................................................................4-3
- The OpenLynx Manager Dialog..............................................................................................................4-3
- The File Menu........................................................................................................................................4-4
  - Report Location................................................................................................................................4-4
  - Print Report Format.............................................................................................................................4-5
- The Administration Menu......................................................................................................................4-5
  - Set Bed Layout..................................................................................................................................4-5
  - Clear Job Queue................................................................................................................................4-6
  - Reset Bed Status.................................................................................................................................4-6
  - E-Mail..................................................................................................................................................4-7
Chapter 5 OpenLynx Login ........................................................................................................... 5-1
Contents ........................................................................................................................................ 5-2
Figures....................................................................................................................................... 5-2
Overview................................................................................................................................... 5-3
The OpenLynx Login Dialog ...................................................................................................... 5-3
The Status Bar............................................................................................................................ 5-3
QC Setup.................................................................................................................................... 5-4
Reset Login Position .................................................................................................................. 5-6
Sample Login............................................................................................................................... 5-6
Plate Login................................................................................................................................ 5-7
Creating Delimited Files ............................................................................................................ 5-11
The File Menu.......................................................................................................................... 5-12
Methods.................................................................................................................................... 5-12
Status......................................................................................................................................... 5-13
HPLC File Location...................................................................................................................... 5-13
Options....................................................................................................................................... 5-14
The Security Menu..................................................................................................................... 5-16
Swap Mode ............................................................................................................................... 5-16
Mode .......................................................................................................................................... 5-17
Wizard...................................................................................................................................... 5-17
Timeout...................................................................................................................................... 5-19

Chapter 6 Registry Settings ......................................................................................................... 6-1
Contents ........................................................................................................................................ 6-2
Figures....................................................................................................................................... 6-2
Introduction................................................................................................................................. 6-3
Initial Settings............................................................................................................................ 6-3
OpenLynx Browser..................................................................................................................... 6-3
OpenLynx ................................................................................................................................... 6-3
To Edit a Registry Setting ......................................................................................................... 6-4
The Initial Registry Settings...................................................................................................... 6-5
OpenLynx ................................................................................................................................... 6-5
Batch Manager .......................................................................................................................... 6-5
Login......................................................................................................................................... 6-5
Chapter 1 Introduction
# Contents

Overview .................................................................................................................. 1-3  
Assumptions ............................................................................................................. 1-3  
The Life Cycle of a Sample ...................................................................................... 1-4  
Reprocessing Samples ............................................................................................ 1-4  
OpenLynx Modes of Operation .............................................................................. 1-5  
  Open Access Walk Up Single Sample Loop ................................................................. 1-5  
  Open Access Walk Up Single Sample LC ................................................................. 1-5  
  Open Access Walk Up Micro Titre Plate Login (Loop) ........................................... 1-5  
  Open Access Walk Up Micro Titre Plate Login (LC) .............................................. 1-5  
Initial Installation and Test ..................................................................................... 1-5  
  Installing the MSPC software .................................................................................. 1-6  
  Setting Up the Network Connection ...................................................................... 1-6  
  Installing the Login Software ................................................................................. 1-7  
  Installing the Browser Software .............................................................................. 1-8

# Figures

Figure 1.1 The OpenLynx LC System ......................................................................... 1-3  
Figure 1.2 Properties dialog .................................................................................... 1-6  
Figure 1.3 The New Share dialog ............................................................................ 1-7
Overview

This document covers the installation, configuration and use of the OpenLynx software. OpenLynx provides an easy to use interface to a Micromass UK Ltd liquid chromatography-mass spectrometry system (LC-MS) for people who are not familiar with operating such an instrument.

There are two separate parts of OpenLynx: the LC-MS system, which is controlled using the MSPC (mass spectrometry computer); and the LoginPC, where samples are logged in. The two computers are linked via a network (see Figure 1.1). Whilst anybody can log in samples, only trained mass spectrometry operators should set up the LC-MS.

When the system is fully operational, the LoginPC provides a list of methods which contain all the information required for analysis. To analyse a sample, the submitter must select the appropriate method and enter some sample information. The sample analysis is then fully automated: the LoginPC tells the chemist where to place the sample in the autosampler rack; and the sample method is downloaded to the MSPC. The system works on a first in, first out (FIFO) principle. When the sample has been analysed, the data is processed and the results can be printed, e-mailed and viewed in the OpenLynx Browser. Thus, within a short time, the chemist obtains detailed information about the sample.

Assumptions

It is assumed in this document that the person installing and configuring OpenLynx has a working knowledge of the following:

1. Microsoft Windows NT
2. LC-MS and MassLynx
3. Networking PCs
4. Sharing disk drives and directories across a network
Connecting to network disk drives and directories

Sharing printers across a network

Connecting to network printers.

The Life Cycle of a Sample

A sample begins at the Login workstation. The OpenLYNX login program produces an OpenLYNX Batch File with a .OLB extension. The OpenLYNX batch file is read and validated by the OpenLYNX Manager and an internal “Sample List” is produced. This “Sample List” is then submitted to the MassLYNX queue, which can be viewed from the main MassLYNX screen.

Once the Sample Batch is in the MassLYNX sample queue then the MassLYNX process manager waits for the sample list to be acquired and processed. (The MassLYNX process manager is the component of MassLYNX that executes MassLYNX sample lists and is different to the OpenLYNX manager). The Processing is performed on each sample in turn after it has been acquired. The OpenLYNX.exe program performs the post acquisition processing. It creates or appends to the OpenLYNX report file depending on if it is the first sample in the batch.

An OpenLYNX batch file is able to hold from one to \( n \) samples where \( n \) is the number of unallocated sample positions on the current autosampler. For example, a Gilson 215 running ten 96 well microtitre plates, it is possible to submit 960 samples in one batch. Please be warned that if this was to be attempted it will take several minutes before the first sample is injected due to the validation which takes place on the batch.

On processing a batch the OpenLYNX batch file is moved to an OpenLYNX\BatchDB\Processed folder. Depending on the configuration of the OpenLYNX Manager an automatic printout of the sample batch may occur. The OpenLYNX report file *.rpt is written to the location specified by the OpenLYNX Manager and can be viewed using the OpenLYNX Browser.

Reprocessing Samples

It is possible to reprocess a previously acquired sample and generate a printed report. For each batch / sample acquired OpenLYNX generates a file with the extension .OLB in the directory C:\MASSLYNX\OpenLYNX\BatchDB\Processed as described above. To reprocess a sample (without reacquiring the data)

From the Sample List choose Import Worksheet from the File menu. For the sample you want to process select the C:\MASSLYNX\OpenLYNX\BatchDB\Processed \filename.olb that corresponds to the sample and choose OK. This will automatically configure the correct columns in the Sample List. An example is shown below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>LOOP01</td>
</tr>
<tr>
<td>Process</td>
<td>C:\MASSLYNX\OPENLYNX.EXE</td>
</tr>
<tr>
<td>Parameter File</td>
<td>C:\MASSLYNX\LOOP.OLP</td>
</tr>
</tbody>
</table>

This will reprocess the data using the Loop.olp OpenLYNX method. If the current sample list is called OLTEST.SPL then the results will be saved to the \sampledb\oltest.rpt file in the current MassLYNX project.
OpenLynx Modes of Operation

The main modes of operation for OpenLynx are:

**Open Access Walk Up Single Sample Loop**

This OpenLynx Method file can be used to acquire and automatically printout the results of a loop injection. All the user has to do is select Loop processing and a Loop time on the Walk-Up page of the OpenLynx Setup as well as reporting MS Spectra on the MS Data page. An example OpenLynx method file called LOOP.OLP is distributed with MassLynx.

**Open Access Walk Up Single Sample LC**

Here the user will not select Loop or a loop time but will select the chromatograms they wish to peak detect by editing the MS data, DAD Data and Analog Data pages. An example OpenLynx method file called LC.OLP is distributed with MassLynx. The ability to automatically process various chromatograms of interest i.e. TIC, Masses and DAD traces to target and hence report Mass Spectra or Diode Array Spectra for the chemist in an Open Access environment is perhaps the most powerful tool OpenLynx has to offer the walk up chemist.

**Open Access Walk Up Micro Titre Plate Login (Loop)**

This is typically used in Combinatorial Drug Discovery. The samples are entered via a TAB delimited text file or clipboard import from within the OpenLynx Login software. The format of this file is set by the Input Fields section of the Walk-up page of the OpenLynx setup program. The Report formats of the OpenLynx using Plate login are generally modified over the Single Sample reports to include Plate and Sample summaries.

Batch/Single Shot entry is enabled via the OpenLynx Manager.

OpenLynx is configured to report the presence or not of target compounds/masses by the Spectrum Test Page of the OpenLynx setup. Pressing the Diversity button enables this “target mass” reporting.

**Open Access Walk Up Micro Titre Plate Login (LC)**

The same as Single sample walk up, but this will acquire and automatically peak detect the chromatogram traces the user specifies in the OpenLynx method.

**All the above but not walk up**

The user is able to generate MassLynx sample lists if they wish. The OpenLynx.exe program is able to process the samples and the user must select the correct OpenLynx method files and acquisition parameters. The OpenLynx Manager would not be active in this mode.

**Initial Installation and Test**

This section describes the steps involved in installing the OpenLynx software and testing the system with the default files. Further information on installation is available in the Installation Chapter of the main MassLynx manual.
All the installation files are on the main MassLynx CD. The OpenLynx Option disk will be requested for the installation of OpenLynx, OALogin, and the Diversity Browser if it is installed on another PC.

**Installing the MSPC software**

The MSPC (Mass Spectrometry PC) should be using the **Windows NT/2000** operating system. Install MassLynx on the MSPC from the MassLynx CD, see the "Installing MassLynx" chapter of the MassLynx User's Guide.

During the installation you will be asked to select the **Options** you wish to install. You should select **OpenLynx, OpenLynx Data** and any other options you wish to install.

Check the instrument and the LC system are working correctly and that you can acquire multiple samples from the MassLynx Sample List.

**Setting Up the Network Connection**

**Note:** The network connection must be set up before the Login software is installed. If it is not then the installation of the software will fail. There will be slight differences between Windows NT and Windows 2000 (described here).

The MSPC and LoginPC must be connected using the TCP/IP network protocol.
When the network has been installed:

1. Open Windows NT Explorer on the MSPC.
2. Click with the right mouse button on the C:\ directory.
3. Select Sharing… from the pop-up menu to display the Properties dialog (Figure 1.2).
4. On the sharing tab check the Shared As option and press the New Share button.

![Figure 1.3 The New Share dialog](image)

5. Enter a Share Name, C is recommended.
6. For the User Limit, check Maximum Allowed or Allow and enter the number of users allowed.
7. Press the Permissions button and ensure that Full Control is enabled.
9. From the OpenLynx Logon window of the LoginPC, in Administrator mode, choose Status from the File menu and select the appropriate OpenLynx Status (*.ols) file.

On the MSPC, load MassLynx. Open the tune page to initialise communications and load the OpenLynx LC Control program.

### Installing the Login Software

The LoginPC should be using the Windows NT/2000 operating system.

**To install the Login software under Windows NT**

1. Insert the main MassLynx CD into the CD drive. If necessary cancel the main MassLynx Installation.
2. Press the Start button to display the Start menu.
3. Select Run…
4. In the Command Line text box, enter d:\oalogin\setup

**Note:** The drive letter of the CD drive may be different on other PCs.
5. Press the OK button.
6. Wait for the OpenLynx Login installation set-up window to be displayed and select the default destination directory.
7. Insert the OpenLynx Login disk into drive a:\ as prompted. The files will be copied onto the LoginPC.

When the installation is complete there will be a new program group, OpenLynx Login, with one item in, OpenLynx Login.

To set up a shortcut

1. Press Start button, choose Programs and then Windows NT Explorer.
2. Select the OpenLynx Login folder then click on the OALogin.exe icon and drag it out onto the desktop

To start OpenLynx Login in future just double click on the shortcut to OALogin icon on the desktop. Alternatively, press the Start button, choose Programs, OpenLynx Login and then OpenLynx Login.

Installing the Browser Software

The OpenLynx Browser can also be installed as a separate program. This may be useful for viewing and generating reports from a different PC.

To install the Browser software under Windows NT

1. Insert the main MassLynx CD into the CD drive. If necessary cancel the main MassLynx Installation.
2. Press the Start button to display the Start menu.
3. Select Run... and enter d:\diverse\setup in the Command Line text box.

Note: The drive letter of the CD drive may be different on other PCs.
4. Press the OK button.
5. Wait for the OpenLynx Browser installation set-up window to be displayed and select the default destination directory.
6. Insert the OpenLynx Browser disk into drive a:\ as prompted.

When the installation is complete there will be a new program group, MassLynx OpenLynx Browser, containing the OpenLynx Browser item.
Chapter 2 OpenLynx Setup
Chapter 2 OpenLynx Setup

Contents

Chapter 2 OpenLynx Setup ................................................................. 2-1
Contents .......................................................................................... 2-2
Figures ............................................................................................ 2-3
Overview ....................................................................................... 2-5
OpenLynx Setup Configuration Wizard .......................................... 2-5
User Interface .................................................................................. 2-6
Selecting Tabs to Display ............................................................... 2-7
  The OpenLynx Setup Toolbar ....................................................... 2-8
Getting Started .............................................................................. 2-9
Walk-up Page .................................................................................. 2-9
  Input Fields .................................................................................. 2-11
Printing Page .................................................................................. 2-12
MS Data Page ............................................................................... 2-13
DAD Data Page ............................................................................ 2-14
Analog Data Page .......................................................................... 2-16
Instrument Page ........................................................................... 2-17
MS Process Page ........................................................................... 2-19
  Combine Parameters ................................................................. 2-20
  Isotope Modelling ..................................................................... 2-22
  MaxEnt ..................................................................................... 2-22
  Mass Measure MS Data ........................................................... 2-23
  AFAMM Parameters ............................................................... 2-24
  Isotopic Cluster Analysis ........................................................ 2-25
Spectrum Test Page ........................................................................ 2-27
Chromatogram Test Page .............................................................. 2-28
Quality Control Page ..................................................................... 2-29
Quantify Page ............................................................................... 2-32
Library Page ............................................................................... 2-33
  Select Library .......................................................................... 2-33
  Search Library .......................................................................... 2-34
  Build Library .......................................................................... 2-36
  Elemental Page ...................................................................... 2-36
Acquisition Process Page .............................................................. 2-37
OpenLynx Global Server Page ...................................................... 2-38
OAQuantify Page .......................................................................... 2-40
  Open Access QuanOptimize .................................................... 2-40
  Open Access Quantitation ....................................................... 2-41
Figures

Figure 2.1 The Configure OpenLynx Setup dialog ................................................................. 2-5
Figure 2.2 Page 1 of the Configuration Wizard ................................................................. 2-6
Figure 2.3 The OpenLynx User Interface ......................................................................... 2-7
Figure 2.4 The Select View Options dialog ..................................................................... 2-8
Figure 2.5 The Setup Toolbar ......................................................................................... 2-8
Figure 2.6 The Walk-up Page ......................................................................................... 2-10
Figure 2.7 The Field Mapper Dialog ............................................................................. 2-11
Figure 2.8 The Printing Page ......................................................................................... 2-12
Figure 2.9 The MS Data Page ....................................................................................... 2-13
Figure 2.10 The DAD Data Page .................................................................................... 2-15
Figure 2.11 The Analog Data Page ................................................................................ 2-16
Figure 2.12 Editing an item to the list control on the Adducts page ......................... 2-17
Figure 2.13 The Instrument Page .................................................................................. 2-18
Figure 2.14 The MS Process Page .................................................................................. 2-19
Figure 2.15 The combine regions of a chromatographic peak ..................................... 2-20
Figure 2.16 The combine regions of a chromatographic peak ..................................... 2-21
Figure 2.17 The Isotope Modelling Dialog Box ............................................................. 2-22
Figure 2.18 The MaxEnt Dialog .................................................................................... 2-23
Figure 2.19 The Mass Measure dialog .......................................................................... 2-23
Figure 2.20 AFAMM Parameters dialog ....................................................................... 2-24
Figure 2.21 The Isotopic Analysis dialog ..................................................................... 2-25
Figure 2.22 The Spectrum Test Page ............................................................................ 2-27
Figure 2.23 The Chromatogram Test Page ................................................................... 2-29
Figure 2.24 The Quality Control Page ........................................................................... 2-30
Figure 2.25 The Stream Parameters dialog .................................................................. 2-31
Figure 2.26 The Quantify Page ..................................................................................... 2-32
Figure 2.27 The Library Page ........................................................................................ 2-33
Figure 2.28 The Library Selection dialog ..................................................................... 2-34
Figure 2.29 The Library Search Settings dialog ............................................................ 2-35
Figure 2.30 The Library Build Setting dialog ................................................................. 2-36
Figure 2.31 The Elemental Page ................................................................................... 2-37
Figure 2.32 The Acquisition Process Page ..................................................................... 2-38
Figure 2.33 The OpenLynx Global Server Page ............................................................. 2-39
Figure 2.34 The OAQuantify Page ................................................................................ 2-40
Figure 2.35 Batch Manager ........................................................................................... 2-42
Overview

OpenLynx Setup is used to develop OpenLynx methods for use by MassLynx. The OpenLynx methods describe how a sample will be acquired and the processing to be applied to the sample. The OpenLynx methods have *.olp file extensions and can be found in the main MassLynx installation directory.

The setup of the OpenLynx method files allows the operator to configure OpenLynx for a variety of applications.

OpenLynx Setup is accessed via the top level MassLynx window. Select OpenLynx, OpenLynx Setup from the MassLynx Shortcut bar. Individual pages are viewed by clicking the relevant tab. (Figure 2.3)

OpenLynx Setup Configuration Wizard

On opening OpenLynx Setup for the first time the user is presented with the following dialog box.

![Configure OpenLynx Setup dialog](image)

Figure 2.1 The Configure OpenLynx Setup dialog

Clicking No will bring up the OpenLynx Setup property sheet with all the Sixteen property pages present (Figure 2.3). Clicking Yes brings up the Configuration Wizard. This allows the user to select which property pages are required on the OpenLynx property sheet.

There are five pages to the Wizard, all the check boxes are unchecked by default. If none of the pages are selected The Walk-up page, MSData page, Instrument page, MS Process page and Spectrum Test page are the only pages present if none of the Wizard options are selected. These pages cannot be removed.

By checking the relevant boxes in the configuration wizard (Figure 2.2) one can select which pages and processes that will be shown on the OpenLynx Setup dialog box Figure 2.3. Each page of the Wizard can be accessed through the Back and Next buttons, on the fifth page clicking on the Finish button will close the Wizard.
User Interface

Once the configuration Wizard is complete the OpenLynx Setup dialog is displayed with, depending on the selections within the Wizard, up to sixteen pages. Also included is a standard windows tool bar and menu options.

- **Walk-up Page**: Allows method files to be selected.
- **Printing Page**: Allows the required report scheme to be selected.
- **MS Data Page**: Allows Integration parameters for TIC, BPI and Mass Chromatograms to be defined.
- **DAD Data Page**: Allows Integration parameters for DAD Data to be defined.
- **Analog Data Page**: Allows Integration parameters for Analog Data to be defined.
- **Instrument Page**: Allows positive and negative Adducts, Charges and Multimers to be defined.
- **MS Process Page**: Allows parameters for processing spectra. (Combine, Mass Measure and Isotope Modelling) to be defined.
- **Spectrum Test Page**: Allows parameters that decide if spectra are acceptable to be defined.
- **Chromatogram Test Page**: Allows an area threshold to be defined, the chromatogram peak area must be greater than this to be displayed as found in the OpenLynx Browser.
- **Quality Control Page**: Used to check that the mass spectrometer and HPLC system are working correctly and to ensure the consistency of data acquired.
- **Quantify Page**: Allows the parameters to be defined so that OpenLynx can calculate the concentration and amount of sample based on the areas of peaks detected.
Library Page
This page allows a library to be defined that will be used to search for results and to append any acquired spectra.

Elemental Page
Allows users to perform Elemental Composition calculations.

Acquisition Process Page
Allows users to define extra processing which will be performed on the files at the time of acquisition.

OpenLynx Global Server Page
This page is used to set up details of the database to which the data will be sent during processing.

OAQuantify Page
Allows QuanOptimize to be run through OA Login.

Selecting Tabs to Display
Once the Configuration Wizard has run, Tabs and Processing Options can be displayed or hidden as required by selecting View, View Options, Figure 2.4 (below) is displayed. By checking the relevant options, extra tabs and processes can be displayed.
The OpenLynx Setup Toolbar

Figure 2.5 The Setup Toolbar

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Menu equivalent</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>File, New</td>
<td>File, New</td>
<td>Create a new OpenLynx parameter file.</td>
</tr>
<tr>
<td>File, Open</td>
<td>File, Open</td>
<td>Open an existing OpenLynx parameter file.</td>
</tr>
<tr>
<td>File, Save or</td>
<td>File, Save or</td>
<td>Save an OpenLynx parameter file.</td>
</tr>
<tr>
<td>File, Save As</td>
<td>File, Save As</td>
<td>Save an OpenLynx parameter file.</td>
</tr>
<tr>
<td>File, Print</td>
<td>File, Print</td>
<td>Print a summary of the Setup file.</td>
</tr>
<tr>
<td>Edit, Cut</td>
<td>Edit, Cut</td>
<td>Cut the selection and put it on the clipboard.</td>
</tr>
<tr>
<td>Edit, Copy</td>
<td>Edit, Copy</td>
<td>Copy the selection and put it on the clipboard.</td>
</tr>
<tr>
<td>Edit, Paste</td>
<td>Edit, Paste</td>
<td>Paste the contents of the clipboard.</td>
</tr>
<tr>
<td>Help, About OpenLynx</td>
<td>Help, About</td>
<td>Display program information, version number and copyright.</td>
</tr>
</tbody>
</table>
Getting Started

Before the user can create an OpenLynx parameter file, the acquisition method files must be created in MassLynx. See the relevant sections in the MassLynx User's Guide and the Guide to Data Acquisition for details.

1. In MassLynx, create a new project.
2. Within this project create the relevant acquisition files. MS Tune, MS Method and Inlet Method.
3. Select OpenLynx, Setup

To Create an OpenLynx Parameter File

1. Press the Toolbar button, or select File, New.
2. Enter the required data on each page of the OpenLynx Setup.
3. Press the Toolbar button, or select File, Save / Save As from the. Enter a name for the new OpenLynx parameter file and press OK.

To Open an Existing OpenLynx Parameter File

1. Press the Toolbar button, or select File, Open
2. Select the required OpenLynx file (*.olp) and press Open.

To Print an OpenLynx Parameter File

1. Press the Toolbar button, or select File, Print. The standard Windows Print dialog is displayed.
2. Enter the number of copies to print and press OK.

Walk-up Page

<table>
<thead>
<tr>
<th>Description</th>
<th>Enter a description of the method.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Fields</td>
<td>These are the fields that will be displayed on the LoginPC for user input. For example, Sample Id, Mass, Concentration etc. See Input Fields, on page 2-11 for details on adding and deleting these fields.</td>
</tr>
<tr>
<td>Maximum Samples</td>
<td>Enter the maximum number of samples that can be processed in one OpenLynx login session.</td>
</tr>
<tr>
<td>Priority Process</td>
<td>Check this box to define the job submitted from the OpenLynx Login as a priority process. Note all processes using this method will be priority processes. For more information see “The MassLynx User’s Guide”.</td>
</tr>
</tbody>
</table>
Night Time Process  
Check this box to define the job submitted from the OpenLynx Login as a night time process. **Note:** All processes using this method will be night time processes. For more information see "The MassLynx User's Guide".

![Figure 2.6 The Walk-up Page](image)

**HPLC File**  
Check this box to allow users to define an LC method when logging on a sample. For more information see the OpenLynx Login chapter.

**Time of Analysis**  
Enter the time to analyse one sample. This time is written to the batch file.

**Create Failed Sample Files**  
Check this box if you wish failed sample data to be saved as an OLB file.

**MS Tune**  
This is the tune parameters file. Select the required file from the drop down list box.

**MS Method**  
This is the scanning parameters file. Select the required file from the drop down list box.

**Inlet Method**  
This is the LC parameters file. File extensions will vary depending on the type of inlet selected. Select the required file from the drop down list box.

**Injection Volume**  
Enter the volume of sample to be injected, in microlitres.
Chapter 2 OpenLynx Setup

Pre-Run Method
This is the pre-run parameters file that will be run to condition a column. File extensions will vary depending on the type of inlet selected. Select the required file from the drop down list box.

Post-Run Method
This is the post-run parameters file that will be run to return the column to a known state. File extensions will vary depending on the type of inlet selected. Select the required file from the drop down list box.

Switch Method
This is the method run when a column is switched. File extensions will vary depending on the type of inlet selected. Select the required file from the drop down list box. The switch method is run if the inlet method is different from the previous one.

Fraction Method
This is the fraction collection parameters file. Select the required file from the drop down list box.

Loop Mode
Checking this box will perform a loop injection and should only be used for samples requiring no chromatography.

Loop Time
This is the retention time at which spectral data will be taken during processing.

Input Fields

Input Fields are the fields that will be displayed on the LoginPC for users to enter, e.g. Sample Id, Mass, Concentration etc.

Fields can be added or deleted via the Field Mapper dialog. To access this dialog press the Edit Fields button or double click on one of the Input Fields, or ‘-None-’ if no fields are displayed.

![Field Mapper Dialog](image)

**Figure 2.7 The Field Mapper Dialog**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Fields</td>
<td>Lists the Fields available in the Field Mapper Dialog.</td>
</tr>
<tr>
<td>Order of Fields to Use</td>
<td>Lists the fields that will be displayed on the LoginPC for users.</td>
</tr>
<tr>
<td>Append</td>
<td>Adds a highlighted field to end of list.</td>
</tr>
</tbody>
</table>
Insert

Adds a field immediately before that highlighted in the Order of Fields Box.

Delete

Deletes a highlighted field.

Clear

Deletes all fields.

Field Alias

A more user-friendly description for each Field may be added here.

Printing Page

Figure 2.8 The Printing Page

Walk-up Batch Report Scheme

Enter the name of the Report Scheme to be used when printing results. If not specified, the currently selected scheme will be used. For more information on Report Schemes, see the OpenLynx Browser chapter.

Per Sample Printing

Check this box to print information for each sample. Enter the name of the Sample Report Scheme to be used when printing results. If not specified then the currently selected scheme will be used. For more information on Report Schemes, see the OpenLynx Browser chapter.
MS Data Page

This page allows users to define integration parameters for TIC, BPI and Mass chromatograms.

**Start Time**
This is the retention time at which the integration of data starts and the time from which data is written to the report file.

**End Time**
This is the retention time at which the integration of data stops and the time from which data stops being written to the report file.

**Note:** If Start and End times are left at the default 0.00 then the whole trace will be integrated and written to the report file.

**Min Peak Separation**
If there are two acquisition functions, e.g. a positive and negative, and a peak appears within this time of each other, the peaks are considered to be the same peak. Only one peak time will be used for the peak top time and both peaks will be reported as the same compound.

**Use Fraction Trigger Times**
Checking this box will combine spectra over the fraction collection ranges only.

**Report Chromatogram**
For all types of chromatogram, check this box to write the chromatogram trace to the report file.
Chapter 2 OpenLynx Setup

**Full Range**
For each chromatogram type, check this box to display the full chromatogram in the OpenLynx Browser. If the full chromatogram is displayed, the specified integration range remains the same.

For all types of chromatogram, pressing the button will invoke the Integrate Chromatogram parameters dialog. For more information on integration parameters see "The MassLynx User Guide, Chromatogram chapter".

**Use all detected peaks**
Check this box to use all detected chromatography peaks for targeting Spectra and in Browser reports. If not checked, then a value should be entered into the Maximum peaks box. Maximum peaks specifies the maximum number of peaks to be taken from each chromatogram trace. The largest peaks, based on area, will be chosen.

**Report MS Spectra**
For all types of chromatogram, check this box to write the Spectrum, from the top of the peaks in the chromatogram trace, to the report file. The MS spectra reported when using this function are found by using the Use all detected peaks in the DAD Data Page.

**Fixed Mass Range**
Enter the Mass to search for and the ± Range in which to search for the peak. This is used for generating a mass chromatogram for each sample, without having to enter the same details for each sample on the LoginPC.

**DAD Data Page**
This page (Figure 2.10) allows the user to define integration parameters for TAC, BPI and Wavelength chromatograms.

**Start Time**
This is the retention time at which the integration of data starts and the time from which data is written to the report file.

**End Time**
This is the retention time at which the integration of data stops and the time from which data stops being written to the report file.

*Note:* If Start and End times are left at the default 0.00 then the whole trace will be integrated and written to the report file.

**Offset Time**
The time in minutes used to align the Diode Array detector with the MS data. Normally DAD data is ahead of the Mass Spectrometer and this offset time is added to the raw DAD time therefore only positive values are valid.

**Report Chromatogram**
For all types of chromatogram, check this box to write this chromatogram trace to the report file.
**Full Range**

For each chromatogram type, check this box to display the full chromatogram in the OpenLynx Browser. If the full chromatogram is displayed, the specified integration range remains the same.

For all types of chromatogram, pressing the button will invoke the Integrate Chromatogram parameters dialog. For more information on integration parameters see "The MassLynx User Guide, Chromatogram chapter".

**Figure 2.10 The DAD Data Page**

**Use all detected peaks**

Check this box to use all detected chromatography peaks for targeting Spectra and in Browser reports. If not checked, then a value should be entered into the **Maximum peaks** box. The maximum peaks specifies the maximum number of peaks to be taken from each chromatogram trace. The largest peaks, based on area, will be chosen.

**Report MS Spectra**

Check the box for each type of chromatogram, to write the Spectra, from the top of the peaks in the chromatogram trace to the report file.
Report DAD Spectra

Check the box for each type of chromatogram, to write the DAD Spectra, from the top of the peaks in the chromatogram trace to the report file.

For Fixed Wavelength Range enter the Wavelength to look for and the ± Range to look for the peak in. This is used for generating a wavelength chromatogram for each sample, without having to enter the same details for each sample on the LoginPC.

Analog Data Page

This page allows the user to define integration parameters for up to four channels of Analog chromatograms.

Start Time

This is the retention time at which the integration of data starts and the time from which data is written to the report file.

End Time

This is the retention time at which the integration of data stops and the time from which data stops being written to the report file.

Note: If Start and End times are left at the default 0.00 then the whole trace will be integrated and written to the report file.
### Offset Time
This is time in minutes used to align the Analog detector with the MS data. Normally Analog data is ahead of the Mass Spectrometer and this offset time is added to the raw Analog time, therefore only positive values are valid.

Press the button to invoke the Integrate Chromatogram parameters dialog. For more information on integration parameters see "The MassLynx User Guide, Chromatogram chapter".

### Report Chromatogram
Check this box to write this chromatogram trace to the report file.

### Full Range
For each chromatogram type, check this box to display the full chromatogram in the OpenLynx Browser. If the full chromatogram is displayed, the specified integration range remains the same.

### Use all detected peaks
Check this box to use all detected chromatography peaks for targeting Spectra and in Browser reports. If not checked, then a value should be entered into the **Maximum peaks** box. **Maximum peaks** specifies the maximum number of peaks to be taken from each chromatogram trace. The largest peaks, based on area, will be chosen.

### Report MS Spectra
Check this box to write the Spectra, from the top of the peaks in the chromatogram trace, to the report file.

### Instrument Page
This page allows the user to define positive and negative ion series adducts, charges and multimers. By default no adducts are in either list.

Normally the non-ionized molecular weight is entered in the spreadsheet or on the LoginPC, OpenLynx then adds the adducts specified on this page to determine the target mass. If the ionised molecular weights have been entered then leave this page blank.

### To Add an Adduct

1. If the and buttons are not next to the required ion type (positive or negative), click on any of the column headings. The buttons will move so that they appear to the right of the required ion type.

2. Click on the button. A new line will appear with default values of Adduct = 0.0000, Charge = 1, Multimers = 1 and Desc = blank.

3. To change the default values double click on the required Adduct field. The display will change to allow the user to enter values as below.

4. Change values as required and press Enter. **Note:** For negative adducts the minus sign must be entered.

![Figure 2.12 Editing an item to the list control on the Adducts page.](image)
To Delete an Adduct

1. If the + and – buttons are not next to the required ion type (positive or negative), click on any of the column headings. The buttons will move so that they appear to the right of the required ion type.

2. Click on the required Adduct and press the – button. The selected Adduct will be deleted.

Figure 2.13 The Instrument Page
MS Process Page

Figure 2.14 The MS Process Page

This page allows users to process MS data. The processes available are Combine, Accurate Mass Spectra, Isotope Cluster, AFAMM, Max Ent and Isotope Modelling. Depending on the selections checked during the Configuration Wizard (page 2-5) or in the View Options Dialog (page 2-7), the following options are available.

Threshold Spectra

**Filter Mode**
To define which spectral peaks to display in a Browser report, select **Absolute, Relative %** or **Most Intense Peaks** from the drop down list box.

**Value**
Enter the value above which the peaks must be to be displayed on the spectrum.

**Save Processed Spectra**
Check this box if you require the processed spectra to be saved as processes within the data files.
## Combine Parameters

![Figure 2.15 The combine regions of a chromatographic peak](image)

Combine is used to generate a background subtracted mass spectrum from a chromatographic peak.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Average Before Top</strong></td>
<td>The region of the chromatogram, from the Peak Start to the Peak Top, to use in combine. Corresponds to B in Figure 2.15.</td>
</tr>
<tr>
<td><strong>Average After Top</strong></td>
<td>The region of the chromatogram, from the Peak Top to the Peak End, to use in combine. Corresponds to C in Figure 2.15.</td>
</tr>
<tr>
<td><strong>Offset Before Top</strong></td>
<td>The time in minutes from the end of the background subtract region to the Peak Start. Corresponds to E in Figure 2.15.</td>
</tr>
<tr>
<td><strong>Offset After Top</strong></td>
<td>The time in minutes from the Peak End to the start of the background subtract region. Corresponds to F in Figure 2.15.</td>
</tr>
<tr>
<td><strong>Background Before Top</strong></td>
<td>The region of the chromatogram before the peak top to use for background subtract in combine. Corresponds to A in Figure 2.15.</td>
</tr>
<tr>
<td><strong>Background After Top</strong></td>
<td>The region of the chromatogram after the peak top to use for background subtract in combine. Corresponds to D in Figure 2.15.</td>
</tr>
<tr>
<td><strong>Minimum peak separation</strong></td>
<td>This is the spectral peak width in amu. For centroided data the peak width can be determined from inspection of the tune peaks in the tune page. The Combine algorithm combines peaks within a Minimum peak separation window into a single peak. The default value of 1 is sufficient for most Quadrupole instruments. This should be decreased for accurate mass calculations (a value of around 0.05 is ok for Tof instruments).</td>
</tr>
</tbody>
</table>
Figure 2.16 The combine regions of a chromatographic peak

**Background directly after average region**
The background can be taken from immediately before the **Average Before Top** and immediately after the **Average After Top** regions (as in Figure 2.16). Check this box and set both **Offset Before Top** and **Offset After Top** to zero.

**Use accurate mass spectra**
When running OpenLynx to determine accurate mass (on LCT/QTOF/GCT) only those spectra in which the accurate mass calculations were successful should be used. The lock mass and analyte peaks must be within the count limits, specified in the upper/lower limits boxes. This applies to the centroid data, not continuum data. Checking this box means that only those spectra which have successfully had dead time correction and lock mass adjustment applied to them will be used. OpenLynx will search in the specified Average retention time window. For valid spectra, if processing continuum data, the first single spectrum that has valid accurate mass will be selected, if processing centroided spectra all the valid scans (specified by the user) in the specified retention time range will be combined together. Accurate mass centroid files can be acquired real-time or produced from continuum data using the All File Accurate Mass Measure program.

**Upper Lock Mass Limit**
Enter the upper lock mass limit in counts. This is the maximum intensity that a lock mass peak can have. If the value of the lock mass peak for a spectrum is below this value then the spectrum can be used for accurate mass determination.

*Note:* Only applicable to non-Lockspray systems.

**Lower Lock Mass Limit**
Enter the lower lock mass limit in counts. This is the minimum intensity that a lock mass peak can have. If the value of the lock mass peak for a spectrum is above this value, then the spectrum can be used for accurate mass determination.

*Note:* Only applicable to non-Lockspray systems.
Number of Spectra to Combine

Enter the number of spectra to combine.

Upper Analyte Limit

Enter the upper analyte limit in counts. This is the maximum intensity that the analyte peak can have. If the value of the analyte peak for a spectrum is below this value then the spectrum can be used for accurate mass determination.

Lower Analyte Limit

Enter the lower analyte limit in counts. This is the minimum intensity that the analyte peak can have. If the value of the analyte peak for a spectrum is above this value then the spectrum can be used for accurate mass determination.

Analyte Window

Enter the size of the window, around the mass specified, that the analyte peak must be found in for the spectrum to be used for accurate mass determination. An analyte window of 2 is ±1 Dalton around the mass entered.

Isotope Modelling

Press the Isotope button to display the Isotope modelling dialog, and enter the required values. For more information on Isotope Modelling, see "The MassLynx User's Guide, Isotope Cluster Abundance Plots, in the Spectrum chapter".

MaxEnt

The MaxEnt algorithm uses the method of maximum entropy to produce true molecular mass spectra from multiply charged electrospray spectra.

Press the MaxEnt button to display the MaxEnt dialog, and enter the required values. For more information on MaxEnt see "The MassLynx User's Guide, MaxEnt, in the Spectrum chapter".
Figure 2.18 The MaxEnt Dialog

Mass Measure MS Data

Figure 2.19 The Mass Measure dialog

**Mass Measure**  
Check this box if you require the acquired data to be Mass Measured.

**Data type**  
Select **Standard** or **TOF** from the dropdown list box.

If **TOF** data type is selected two settings buttons are displayed. Press the **Settings MS+** for positive data and **Settings MS-** for negative data.
Press this button to invoke the Mass Measure parameters dialog, and enter the required values. For more information on Mass Measure see "The MassLynx User's Guide, Spectrum chapter".

### AFAMM Parameters

![AFAMM Parameters dialog](image)

**Do AFAMM**  
Check this box to process the data using All File Accurate Mass Measure (AFAMM).

**Process Type**  
From the drop down list box, select the process type that you want to apply to the data.

Depending on the **Process Type** selected the following parameters will be enabled

#### Peak Filter Parameters

**Filter Reference File**  
Press the Browse button and select a Filter Reference File (*.ref) from the displayed dialog. This file removes peaks arising from the reference compound from the acquired data file.

**Filter Parameters**  
Select **Peak Window (ppm)** or **Peak Window (Da)** and enter the required window size.
Secondary Reference Correction Parameters

Filter Reference File Press the Browse button and select a secondary Filter Reference File (*.ref) from the Open dialog. This selects a reference file against which data in an acquired data file can be adjusted.

Peak Match

Peak Window ppm Enter the range to search the data file for a peak that matches one in the reference file. The window is +/- the entered value around the mass defined in the reference file. This means that a value of 250ppm will result in a search window of 500ppm.

Intensity Threshold Enter the percentage of the most intense peak in the spectrum that a peak must be above to be considered as significant.

Lock Mass Peaks Found Enter the percentage of peaks (within the required mass range) in the reference file that must be successfully located in the scan, for that scan to be adjusted for accurate mass.

Largest Peak in Window Select to use the mass of the largest peak in the search window.

Closest Peak in Window Select to use the mass of the peak in the data scan closest to that of the reference file.

Isotopic Cluster Analysis

Press the Isotope Cluster button to display the Isotopic Cluster Analysis dialog.

Isotopic Cluster Analysis Check this box to perform Isotopic Cluster Analysis.

Use Mass Differences Only Select to use the mass differences in the cluster analysis.
### Use Mass Differences and ratios
Select to use the mass differences and ratios in the cluster analysis.

### RT Start Time
Enter the retention time in minutes to start Isotopic Cluster Analysis.

### RT End Time
Enter the retention time in minutes to stop Isotopic Cluster Analysis.

### Start Mass
Enter the mass at which to start Isotopic Cluster Analysis.

### End Mass
Enter the mass at which to stop Isotopic Cluster Analysis.

### Mass Tolerance
Enter the mass tolerance, this will be used with the **First Mass Difference** and **Second Mass Difference** to find the next peak in the cluster. A peak found at the first or second mass difference ± the Mass Tolerance will be considered as part of the cluster.

### Ratio Tolerance
Enter a ratio tolerance, this will be used with the **First Intensity Ratio** and **Second Intensity Ratio** to find the next peak in the cluster. A peak found with the first or second ratio intensity ± the Ratio Tolerance will be considered as part of the cluster.

### Intensity Threshold
Enter the minimum intensity threshold, peaks with an intensity below which this threshold will be ignored.

### Use Second Mass Difference
Check this box if the analyte is likely to have three peaks within a cluster. The Mass 2 values are applied to the mass and intensity ratio between the second and third peaks.

#### Mass 1 and Mass 2 (fields the same for both)

### First Mass Difference
Enter the expected mass difference for the next peak in the cluster, the second peak should be found at this mass within the Mass Tolerance window.

### First Intensity Ratio
Enter the expected intensity ratio (Intensity of peak 2/ Intensity of peak 1), the second peak should be found within the Ratio Tolerance window. This only applies when **Use Mass Differences and Ratios** is selected.

### Predefined Elements
For some elements the **First Mass Difference** and **First Intensity Ratio** have been defined, select the required element from the drop down list box to automatically enter values in these fields.
**Spectrum Test Page**

![Figure 2.22 The Spectrum Test Page](image)

**Overload**
Check this box and enter a value over which spectra will be marked as overloaded.

**Noise**
Check this box and enter a value above which spectra will be marked as noise, e.g. if 10 is entered then if the noise is greater than 10% of the base peak intensity then the spectrum will be marked as noisy.

**Peak Density**
Check the box and enter a value for the minimum number of peaks, which must appear per Dalton.

**Diversity**
These parameters are used to identify peaks in the OpenLynx Browser, to enable these parameters click on the Diversity heading. A second click on the heading will disable the parameters. This option must be enabled and a mass entered on the LoginPC, or in the Sample List, for the Browser to identify target peaks.
Mass Find Mode
Select Nearest or Most Intense from the drop down list box, to select the peak nearest the mass of interest or the most intense peak within the Mass Window.

Mass Window
Enter the size of the window to search the combined spectrum for the entered mass and any adducts. For example a mass window of 2 is ± 1 Dalton around the mass entered.

Threshold Mode
Select Relative or Absolute from the drop down list box, this can be different for MS+ or MS-.

Relative – The peak is compared to the base peak intensity.

Absolute – The ion count must be above the number specified.

Threshold (MS+)
Enter a minimum threshold for positive spectra, above which peaks must be to be included. For example, if a threshold of 20 is entered, the peak must be at least 20% of the base peak intensity.

Confirmation Threshold (MS+)
Enter a threshold for positive spectra, above which peaks must be to be considered a good match. These peaks will be displayed in the found color in the OpenLynx Browser. Peaks which fall between the Threshold and Confirmation Threshold will be displayed in the found tentative color in the OpenLynx Browser.

Threshold (MS-)
Enter a minimum threshold for negative spectra, above which peaks must be to be included. For example, if a threshold of 20 is entered, the peak must be at least 20% of the base peak intensity.

Confirmation Threshold (MS-)
Enter a threshold for negative spectra, above which peaks must be to be considered a good match. These peaks will be displayed in the found color in the OpenLynx Browser. Peaks which fall between the Threshold and Confirmation Threshold will be displayed in the found tentative color in the OpenLynx Browser.

Accurate Mass Error Reporting

Primary Threshold
Check this box, enter a threshold above which peaks must be to be considered as 'Found' and select PPM or mDa from the drop down list box. These peaks will be displayed in the found colour in the OpenLynx Browser.

Secondary Threshold
Check this box, enter a threshold above which peaks must be to be considered as 'Found Tentative' and select PPM or mDa from the drop down list box. Peaks above this threshold but below the Primary Threshold will be displayed in the found tentative color in the OpenLynx Browser.

Chromatogram Test Page
The Chromatogram Test page allows an area threshold to be defined. The area of a chromatogram peak must be above this threshold to be displayed as found in the OpenLynx Browser. This means that the intensity of the peak is being tested in addition to the presence of the compound.

The threshold can be applied to specified types of chromatogram.
**Enable Chromatogram Test**
Check this box to enable chromatogram threshold testing.

**Threshold (%)**
Enter a percentage area of the chromatogram, which the peak must be above, in order to be displayed as 'Found' on the OpenLynx Browser.

**Chromatograms to test**
Check the box for each type of chromatogram that the thresholding test should be applied to.

*Note:* Only chromatograms where the Report Chromatogram checkboxes have been selected on the MS Data, DAD Data and Analog Data pages will be available.

---

**Quality Control Page**

Quality Control checking is used to check that the mass spectrometer and HPLC system are working correctly and to ensure the consistency of data acquired. A QC sample with a known retention time and peak intensity is acquired and the results compared to the values entered on this page.

To use the Quality Control options in OpenLynx Login the QC On box on the QC Options dialog in OpenLynx Login must be selected.
Figure 2.24 The Quality Control Page

**QC Required**  
Check this box if QC checking is required.

**Multi-probe Capability**  
Check this box if a MUX system is to be used.

**Probes**  
Enter the number of probes on the MUX system. The corresponding number of Stream buttons will be enabled.

**Trace**  
From the drop down list box, select the type of chromatogram trace against which to compare the QC Samples.

**+/- RT (mins)**  
Enter the retention time tolerance, this will be used with the Retention Time(s) defined on the Stream Parameters dialog (see below) to decide if the peak has passed the QC test. A peak found at the Retention Time ± the RT (mins) will be considered as passing the test.

**+/- Peak Area**  
Enter the peak area tolerance, this will be used with the % Total Area(s) defined on the Stream Parameters dialog (see below) to decide if the peak has passed the QC test. A peak found with the % Total Area ± the Peak Area will be considered as passing the test.

**QC Failure E-Mail**  
Enables a specific a text message to be sent automatically by E-Mail if a QC sample fails. The subject of the e-mail will be "QC Failure".
E-Mail Address  
Enter the e-mail address to which the QC Failure e-mail should be sent.

E-Mail Text  
Enter the message that the QC Failure e-mail should contain.

Stream $n$  
To define the parameters of a particular probe, press the relevant Stream button. The Stream Parameters dialog is displayed.

![Stream Parameters dialog](image)

Figure 2.25 The Stream Parameters dialog

Retention Time  
Enter the expected retention time of the peak in the QC sample.

% Total Area  
Enter the area of the chosen peak, as a percentage of the total area of all the peaks. If the peak area is not equal to the value specified, $\pm$ Peak Area (defined on the Quality Control page), then the QC will fail.

Peak 2 and Peak 3  
Check these boxes and enter the Retention Time and % Total Area for additional peaks.

Mode  
Select Relative % or Absolute from the drop down list box. Relative % is the specified Min Intensity as a percentage relative to the base peak. Absolute is the absolute intensity specified in the Min Intensity field.

Min Intensity  
Enter the intensity (Relative % or Absolute), which the specified peaks must be above in order for the QC Sample to be passed.
Quantify Page

This page allows the parameters to be defined so that OpenLynx can calculate the concentration and amount of sample based on the areas of peaks detected. These values will be displayed in the Concentration and Amount columns on the OpenLynx Browser. For more information see "The MassLynx User's Guide, Quantify chapter".

The amount is calculated as Concentration x Factor 1.

**Disable**
Select this option if quantification is not required.

**Use calibration coefficients**
Select this option for values calculated externally and enter the coefficients of the calibration curve in the C0, C1 and C2 fields.

**Use MassLynx Quantify calibration file (*.cbd)**
Select this option to use a calibration file created in MassLynx.

**Chromatogram Trace**
Select this type of chromatograms to be quantified from the drop down list box.

Note: Only the first calibration in the file will be used.
User Factor

**User Factor**
Select this option and enter the number of nitrogens to use as the division factor for adjusting the concentration of the data obtained.

**Number of Nitrogens in Formula**
Select this option to use the number of nitrogens in the input formula as the division factor for adjusting the concentration of the data obtained.

Library Page

![Image of Library Page](image)

**Figure 2.27 The Library Page**

Use this page to define a library that will be used to search for results and to append any acquired spectra to. For more information on library searching see the Library chapter in the MassLynx User’s Guide.

**Select Library**

**Name**
Enter the name of the required library or select one from the dropdown list box.

**Advanced**
Press this button to display the Library selection dialog.
Figure 2.28 The Library Selection dialog

**Library location (directory)**
Enter the name of the directory in which the libraries are located.

A library can be created containing all spectra or spectra can be split into MS positive, MS negative Diode array categories. E.g. Lib1 can be created with all spectra or can be created as three libraries lib1(MS+), lib1(MS-) and lib1(UV).

**Append data type postscript to library names**
Check this box to allow the different data types to be Searched/Stored in separate libraries.

**MS positive spectra (MS+)**
**MS negative spectra (MS-)**
**Diode array spectra (UV)**

**Search Library**

**Perform library search on spectra**
Check this box to perform a library search, using the results acquired.

**Settings**
Press this button to display the Library Search Settings dialog.

**Number of library hits to report**
The result of a Library search is a list of library compounds or "hits" whose spectra give the best match with the unknown spectrum. Enter the number of hits to be reported.

**Rank library hits by**
Select one of Forward Fit or Reverse Fit. The Forward fit value shows how likely it is that the search spectrum is a pure sample of the Library entry. The Reverse fit value shows how likely it is that the search spectrum contains the Library entry, in this case the search spectrum may be a mixture of compounds.

**Search n largest peaks in spectrum**
Enter the number of spectral peaks to be compared during the search.
Figure 2.29 The Library Search Settings dialog

**Minimum Search Fit** Specify a **Minimum Forward** and/or a **Minimum Reverse** fit value, which a Library entry must have before it will appear in the Hit list. To make the filter active the user should type a value between 0 and 1000 into the edit control.

**Library Presearch** Use these options to define the speed and accuracy of a search. The library presearch file contains a spectrum, for each library entry, which has been reduced to the 8 most intense mass-weighted peaks. The unknown spectrum is reduced to its 8 most intense mass-weighted peaks and then compared to the library presearch file.

- **No Presearch** All peaks will be compared to all library entries. This is the most accurate method of searching, but will also take the most time.
- **Main search top n presearch matches** Takes the top n matches from the presearch and compares the unknown with them.
- **Main search entries with n% presearch fit** Takes all entries with an n% fit or above from the presearch and compares the unknown with them.

**Search Filters** To refine a search further the user can specify filters.

- **Retention time with window (min +/-)** Check box that allows a time range to be specified within which the library entry must be.
Retention index with window (+/–)  
Check box that allows a retention index range to be specified within which the library entry must be.

Note: Both the library entry and the unknown must have had a retention index calibration performed on it.

Build Library

Automatically append spectra to library  
Check this box to append acquired spectra to the library named above.

Settings  
Press this button to display the Library selection dialog.

Create library if doesn’t already exit  
Check this box if the library named in the Library Search section does not exist and the Automatically append spectra to library box has been checked. A new library will be created when processing is complete.

Maximum number of peaks in entry  
Enter the maximum number of peaks to be saved with an entry.

Elemental Page

This page allows users to perform Elemental Composition calculations. For more information on elemental composition see the Spectrum chapter in the MassLynx User’s Guide.

Perform Elemental Composition  
Check this box to perform elemental composition calculations.

Browse  
Press this button and select an elemental composition settings file (*.els) from the browser displayed. These files are created in the elemental composition program and contain the parameters to be used to search with.

Perform Restricted Search  
Check this box to restrict the search to those elements defined in the Formula entered in the Sample List. The limit on the elements is set in the *.els file selected.

E.g. Sample list contains the formula C23H45N7O6F2. *.els file has From 0 To 30 for H (on the Symbol Parameters page)  
The search will only be for the elements C, H, N, O and F and a composition containing a maximum of 30 Hydrgens.
Perform Full Spectrum Scan

If this box is not checked, then the elemental calculations are performed for peaks found at the masses entered on the Login screen. If this box is checked and a value entered in the Number of Peaks box, and if peaks are not found at the masses entered on the Login screen, the software will search the spectrum and perform elemental calculations on the largest peaks above the threshold.

Threshold (abs) and Threshold (%)

Select one of these options and enter a value above which peaks must be to be included in the elemental calculations.

![Figure 2.31 The Elemental Page](image)

**Acquisition Process Page**

This page allows users to define extra processing which will be performed on the files at the time of acquisition. For example ChroSplit.exe for splitting Batch data files acquired using the Gilson Multi-Injector. If files are reprocessed this processing will not be performed.

**Acquisition Process**

Click Browse and select the required *.exe file from the dialog displayed.

**Acquisition Parameter File**

Click Browse and select the required file from the dialog displayed.
Acquisition Process Options

Enter the string of characters, which define the required process options.

OpenLynx Global Server Page

This page is used to set up details of the database to which the data will be sent during processing.

Insert Data into Oracle Database

Allows the OpenLynx processing to insert the data into an Oracle database. Checking this box enables the other fields on the page.

DataBase Name

The unique id (SID) of the Oracle database.

Webserver Host Name

The Name of the server where the webserver resides, as it appears in the clients hosts file.

Webserver Port Number

The port number of the server which the webserver runs off. This value is usually 8080.
Append Status To Log File

Selects whether the insert status for a sample should be appended to a log file. If selected then the insert status for every single sample will be added to a log file called "OpenLynxOracle.log". If the file exists the entry for a sample will be appended. If the file does not exist then the file will be created in the MassLynx installation directory and the entry will be inserted. The log file will contain the Batch ID, Sample ID, Insert Status, and the date and time.

E-Mail Oracle Insert Failure

If any insert failures occur during a batch then an e-mail will be sent to the e-mail address provided. Details of all the samples within a batch that had an insert failure will be included in the e-mail. Checking the box enables the edit field.

Duplicate Sample

This section is used to select what action to take in case a duplicate sample is present in the database. One of three options can be selected:

Do Not Insert

The sample is not inserted into the database. This button is selected by default.

Overwrite All Duplicates

The sample data is written over the existing sample data.
Append as New  
The sample data is appended to the database as a new sample.

OAQuantify Page

Open Access QuanOptimize

To run QuanOptimize through OA Login select the OA Quantify page (Figure 2.34). The OpenLynx method is used to specify one particular parameter set to use for a QuanOptimize experiment. An OpenLynx method should be created for each different type of QuanOptimize experiment to run.

Check the Open Access QuanOptimize box to enable the QuanOptimize Parameters.

- **OAQuanOptimise**  
  Check box to activate QuanOptimize in OpenLynx

- **Optimisation**  
  Select this box to enable compound optimization

- **Acquisition**  
  Select this to enable the analysis part of QuanOptimize

- **QuanLynx Method**  
  Specifies the QuanLynx Method to use.

- **Quantitation Method**  
  Specifies which Quantitation method to use.

---

Figure 2.34 The OAQuantify Page
Open Access Quantitation

Open Access Quantitation is a method to run Quantitation analyses through an open access login system. The conditions required for a particular quantitation analysis are stored within a specific OpenLynx method, which is selected during the login process.

The OpenLynx method controls the acquisition parameters (LC method, tune file, etc.), the quantitation options (integrate, calibrate, quantify, etc.) and the quantitation method. The user can therefore select a particular set of experimental conditions, by simply choosing the appropriate method; only the sample list has to be supplied.

Check the Open Access Quantitation box to enable the Quantitation Parameters.

- **Integrate Samples**: Integrates all the sample data files named in the Sample List.
- **Calibrate Standards**: Uses Integration results to form Quantify calibration curves. Do not select this option if an existing calibration is to be used; in this case use the Curve: Browse button to select the desired calibration file.
- **Quantify Samples**: Uses Integration results and Quantify calibration curves to calculate compound concentrations.
- **Print Quantify Reports**: Produces hard copies of the results of integration and quantitation.
- **Export Results to LIMS**: Produces a text file containing the quantitation results details for use with LIMS systems. If this option is selected, the LIMS Export File: Browse button is enabled; press the Browse button and select a file, or enter the name of a new one, and press Save. Refer to the Export section of Chapter 3, The QuanLynx Browser, for further details.
- **Update Method Times**: Select this option to update the Peak Location Retention Time of compounds in the Quantify Method. This operation will modify the Dataset Method. This is useful if compound elution times have changed due to different Liquid Chromatography (LC) conditions.

A reference sample is required for this process to operate; a high-level calibration standard could be used for this purpose. The reference sample should be indicated by placing an ‘x’ in the MassLynx Sample List Quan Reference column before the Dataset is created.

- **Quantitation Method**: Select a Quantitation Method File.
- **Calibration File**: If Calibrate Standards is not selected then the user can provide a calibration file to use for the quantitation stage, otherwise the calibration file is grayed out.

**Method Setup**

- The Quantitation options are selected on the OAQuantify Page.
- The acquisition parameters are set on the Walk-up Page (page 2-9).
- The Input Fields control the sample list columns required during login.
Quantitation Login

From the Login screen select **Login Samples...** to start the Login Wizard (see Chapter 5).

1. On the first page the wizard enter the user name, job ID, and then select from a number of options:

   - **Print OpenLynx Report**
     - Not relevant to open access quantitation.

   - **Email Results**
     - If selected, an email address can be entered, where the results files are sent after the batch has been completed. This includes the quantitation results file, and the LIMS Export file, if LIMS Export has been enabled in the OpenLynx method.

   - **QuanLynx results directory**
     - If selected, a directory can be entered, where a copy of the results can saved. This includes the quantitation results file, and the LIMS Export file.

   - **Sample Holders**
     - Select the desired sample holder form the available list. These will be defined as “Single Shot” for log in of individual samples, or “Whole Plate” for log in of a plate of samples.

   - **Single Sample File Login**
     - For “Single Shot” log in the sample information can be entered manually, or if this option is enabled, imported from a text file.

2. On the second page, chose the required OpenLynx method for the desired quantitation experimental conditions.

3. On the third page enter the sample list information. For plate login this is done either by text file import or by cut and paste. For single sample login, the list can be entered manually, or, in the same way as plate login.

4. The last page instructs the user where to place their samples or sample plate.

**Batch Manager**

The Batch Manager (see chapter 4) controls submission of sample batches, which displays a list of batches submitted, and follows their progress.

For quantitation batches, the sample data is acquired, quantified and then the results are handled depending on the login options selected, i.e. either sent by email or saved to a particular location. A copy of the results can always be found in the current project directory.
Contents

Overview ....................................................................................................................... 3-5
Creating Report Files ......................................................................................................... 3-5
The OpenLynx Browser Screen ......................................................................................... 3-5
The OpenLynx Browser Toolbar ....................................................................................... 3-6
Getting Started ................................................................................................................ .............. 3-7
Report Schemes ................................................................................................................. ............ 3-8
Report Scheme Settings ................................................................................................................ 3-8
Print Control Page ............................................................................................................. .3 - 9
Report Column Selection Pages ........................................................................................ 3-10
Decimal Places Page ........................................................................................................... ........... 3-13
View Options ................................................................................................................... ........... 3-13
Spectrum Page ................................................................................................................. 3-13
Chromatogram Page ......................................................................................................... 3-15
Default Plate Page ........................................................................................................... 3-17
Colors Page .................................................................................................................... .. 3-18
Copy Control Page ........................................................................................................... 3-19
Column Pages ................................................................................................................... .......... 3-20
Fraction Display Page ......................................................................................................... 3-21
Other Display Options ............................................................................................................. ....... 3-23
Other Menu Options ............................................................................................................. 3-24
File Menu ...................................................................................................................... ... 3-24
View Menu ...................................................................................................................... 3-25
Window Menu ................................................................................................................... 3-26
The Browser Panes .............................................................................................................. ........ 3-26
The Plate Pane ................................................................................................................... 3-26
The Sample Description Pane .......................................................................................... 3-27
The Fraction Collection Results Pane .............................................................................. 3-28
The Results Table Pane .................................................................................................... 3-28
The Spectrum Pane .......................................................................................................... 3-30
The Elemental Composition Results List / Library Search Results List Pane .......... 3-31
The Elemental Composition Results List ........................................................................... 3-31
The Library Search Results List ....................................................................................... 3-32
The Chromatogram Pane ................................................................................................. 3-32
Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>The OpenLynx browser</td>
</tr>
<tr>
<td>3.2</td>
<td>The Browser Toolbar</td>
</tr>
<tr>
<td>3.3</td>
<td>The Print dialog</td>
</tr>
<tr>
<td>3.4</td>
<td>The Print Control dialog</td>
</tr>
<tr>
<td>3.5</td>
<td>The Edit Report Settings, Print Control Page</td>
</tr>
<tr>
<td>3.6</td>
<td>The Sample Summary Report Page</td>
</tr>
<tr>
<td>3.7</td>
<td>The Decimal Places Page</td>
</tr>
<tr>
<td>3.8</td>
<td>The Spectrum Page</td>
</tr>
<tr>
<td>3.9</td>
<td>The Chromatogram Page</td>
</tr>
<tr>
<td>3.10</td>
<td>The Default Plate Page</td>
</tr>
<tr>
<td>3.11</td>
<td>The Colors Page</td>
</tr>
<tr>
<td>3.12</td>
<td>The Copy Control Page</td>
</tr>
<tr>
<td>3.13</td>
<td>The List Columns Page</td>
</tr>
<tr>
<td>3.14</td>
<td>The Fraction Display Page</td>
</tr>
<tr>
<td>3.15</td>
<td>The Program Not Found dialog</td>
</tr>
<tr>
<td>3.16</td>
<td>The Failed Samples Options dialog</td>
</tr>
<tr>
<td>3.17</td>
<td>The View Menu</td>
</tr>
<tr>
<td>3.18</td>
<td>The Window Menu</td>
</tr>
<tr>
<td>3.19</td>
<td>The Plate Pane</td>
</tr>
<tr>
<td>3.20</td>
<td>The Sample Description Pane</td>
</tr>
<tr>
<td>3.21</td>
<td>The Fraction Collection Results Pane</td>
</tr>
<tr>
<td>3.22</td>
<td>The Results Table Pane</td>
</tr>
<tr>
<td>3.23</td>
<td>The Spectrum Pane</td>
</tr>
<tr>
<td>3.24</td>
<td>The Elemental Composition Results List</td>
</tr>
<tr>
<td>3.25</td>
<td>The Library Search Results List</td>
</tr>
<tr>
<td>3.26</td>
<td>The Chromatogram Pane</td>
</tr>
</tbody>
</table>
Overview

The OpenLynx Browser is used to view OpenLynx Report files, print results or export results to other applications (such as LIMS systems or Excel) via the clipboard or TAB delimited text files.

To access the OpenLynx Browser select OpenLynx, OpenLynx Browser MassLynx Shortcut bar.

The OpenLynx Browser can be installed as a standalone program without MassLynx to allow viewing of results on remote computers.

Creating Report Files

An OpenLynx Browser report file (*.rpt) is created when a job submitted from the LoginPC is processed. Report files can be created from another PC by specifying OpenLynx.exe in the Process column of a Sample List and the OpenLynx Parameters file (*.olp) in the Process Parameter column.

If compound targeting is required, then a mass to search for must be entered via the LoginPC or in the Sample List.

The OpenLynx Browser Screen

The screen is split into 7 panes although some may not be displayed depending on the processing selected in the OpenLynx method. Further information can be found for each pane at the page number indicated.

- The Plate Pane (page 3-26) showing the plate layout and compounds found.

Figure 3.1 The OpenLynx browser
• The Sample Description Pane (page 3-27) showing sample information and whether the compound, being searched for, has been found or not.

• The Fraction Collection Results Pane (page 3-28) showing fraction collection information. This pane will not be displayed if fraction collection has not been performed.

• The Results Table Pane (page 3-28) showing a list of detected compounds.

• The Spectrum Pane (page 3-30) showing the spectrum for the well highlighted and the retention time selected.

• The Elemental Composition Results List / Library Search Results List Pane (page 3-31) showing the results of any Elemental Composition and/or Library searching for the peak selected in the Results Table pane. This pane will not be displayed if both Elemental Composition and Library searching have not been performed.

• The Chromatogram Pane (page 3-32) showing the integrated chromatogram for the well highlighted.

The OpenLynx Browser Toolbar

![The Browser Toolbar](image)

**Figure 3.2 The Browser Toolbar**

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Menu equivalent</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File, Open" /></td>
<td>File, Open</td>
<td>Open an existing OpenLynx Browser report.</td>
</tr>
<tr>
<td><img src="image" alt="Edit, Copy" /></td>
<td>Edit, Copy</td>
<td>Copy the selection and put it on the clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="File, Print" /></td>
<td>File, Print</td>
<td>Print an OpenLynx Browser file.</td>
</tr>
<tr>
<td><img src="image" alt="Go to first Well" /></td>
<td>Go to first Well.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to previous Well" /></td>
<td>Go to previous Well.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to next Well" /></td>
<td>Go to next Well.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to last Well" /></td>
<td>Go to last Well.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Display previous plate" /></td>
<td>Display previous plate.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Display next plate" /></td>
<td>Display next plate.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Display default range" /></td>
<td>Display default range.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Swap Plate View" /></td>
<td>Swap Plate View</td>
<td>Swaps between normal plate view and multiple injection plate view.</td>
</tr>
</tbody>
</table>
View, Swap List View
Swaps between the Elemental Composition and the Library Search Results view.

Help, About OpenLynx
Results Browser
Display program information, version number and copyright.

Getting Started

To Open an Existing OpenLynx Browser File

1. Press the Toolbar button, or select Open from the File menu.
2. Select the required OpenLynx Browser results file (*.rpt) and press Open.

To Copy an OpenLynx Browser File

Plate, Sample Summary and Spectrum List information can be copied to the clipboard and pasted into other Windows applications. See "Copy Control Page" on page 3-19 for more details.

1. Press the Toolbar button, or select Copy from the Edit menu.

To Print an OpenLynx Browser File

1. Press the Toolbar button, or select Print from the File menu. The Print Control dialog is displayed.

   ![Print Control]
   
   Figure 3.3 The Print dialog

2. Select Print Current Sample to print information for the currently selected well.
3. Select Print All to print information for all wells on all plates.
4. Select Print Selection and select a From and To well number from the drop down list boxes.
5. Select Print All Colours Black to print all of the coloured data in black.
6. To change the margin settings for the printed report, press the Margins button. The Set Margins dialog is displayed.

![Set Margins dialog](image)

7. Enter the required width in centimetres for the Top, Bottom, Left and Right margins and press OK.

8. From the Print Control Dialog, press OK to print the report.

Reports can also be printed from Windows NT Explorer. Select the required files and choose Print from the File menu. Note: This method will not allow the user to select which samples are printed.

**Report Schemes**

**To Open a Report Scheme**

1. Select File, Report Scheme Open.
2. Select the required *.ors file from the dialog displayed.
3. Press Open.

**To Save a Report Scheme**

1. Select File, Report Scheme Save As.
2. Select the required location and enter a *.ors filename in the dialog displayed.
3. Press Save.

**Report Scheme Settings**

The information on printed reports can be defined via the Report Scheme Settings dialog. To access the dialog select File, Report Scheme Settings.
Print Control Page

Plate Summary
Check this box to produce a Plate report. This is a picture of the plate showing: ‘1’ for found compounds, ‘?’ for found tentative compounds, ‘0’ for compounds not found, ‘+’ if no compound was searched for, and ‘−’ for unused wells.

Sample Summary
Check this box to produce a summary report for a Sample. Note: The number of samples printed is controlled from the Print Control dialog. See To Print an OpenLynx Browser File, on page 3-7.

Sample Report
Check this box to produce a more detailed report for a sample.

Sample on New Page
Check this box to start each sample of the Sample Report on a new page.

Peak Information Tables
To display peak information tables below a chromatogram, check the box relevant to the type of information required.

Spectra height (mm)
Check this box and enter the required height, to print the spectra associated with a sample.

Chromatogram height (mm)
Check this box and enter the required height, to print the chromatograms associated with a sample.

All Chromatograms On One Axis
Check this box to use one axis for all chromatograms.
Mass Chromatograms / Axis

Check this box and enter the number of chromatograms to display on each axis. This is used to make overlaid mass chromatograms easier to view. The default of 1 will display each chromatogram on a different axis.

Maximum Spectra Displayed

To limit the number of spectra printed on a page, check this box and specify the maximum number of spectra to print.

Side by Side Chromatograms

Check this box to print two chromatograms per line. Note: The Peak information table will not be displayed if this option is chosen.

Side by Side Spectra

Check this box to print two spectra per line. Library search results and elemental calculations will not be displayed if this option is chosen.

Chromatogram Print Order

The order in which chromatograms and spectra are printed can be defined by selecting one of MS First, Analog First or DAD First for chromatograms, and Time Order or Chromatogram Order for spectra.

Page Orientation

Select Portrait or Landscape to print the report with the required page orientation.

Report Column Selection Pages

The basic format of the Report Column Selection pages (Figure 3.6) is the same, each has a list of fields that can appear as column headings on the type of report selected. Click on the corresponding tab for the type of report required. The Report Column Selection pages are:

- Fraction Results Summary Page
- Spectrum Report Page
- Spectrum Search Report Page
- Sample Header Page
- Chromatogram Report Page
- Sample Summary Page
- Results Summary Page
- Report Header Page
- Elemental Report Page
- Decimal Places Page.
To Add a Field

Click on a field in the **Available Fields** box and press the \[+\] button. The new field is added to the bottom of the **Reported Fields** list.

To Remove a Field

Click on the field to remove, in the **Available Fields** box and press the \[-\] button. The field will be removed from the **Reported Fields** list.

To Change the Order of Fields

Click on the field to be moved, in the **Available Fields** box and press the \[\uparrow\] or \[\downarrow\] button until the field is in the required position.

Field Alias

If the field name in the **Available Fields** list does not correspond to a description the user will recognise, enter a different name in the **Alias** box, e.g. State could be displayed on the report as Pass/Fail. This field may also be used to display field names in another language.

To Change the Field Width

Enter a new value in the **Width** box. **Note:** This option is not available on the Sample Header and Report Header pages.
Results Summary Page

The Results Summary page has four extra options, Nominated Results Trace, Largest Peak Only and All Found Peaks.

Select one of the options from the Nominated Results Trace dropdown list box to define which type of trace is used for the calculation of the Area % Total.

If a chromatogram has more than one found peak, you can choose to include the Largest Peak Only, All Found Peaks or All Peaks in the report.

Report Header Page

The Report Header page has four extra fields, Report Header Text, Display report name, Display submitter name and Display date and time.

Enter text to appear at the top of a report in the Report Header Text field. This text will be displayed between the Report name and Submitter name, if selected, see below.

Check the Display report name box to print “OpenLynx Report” at the top of the report. If this text is not required, make sure the box is unchecked and enter your own text in the Report Header Text field as described above.

Check the Display Submitter name box to print the name of the submitter as defined in the OpenLynx Login program (User name).

Check the Display date and time box to print the date and time of printing.

Sample Header Page

The Sample Header page has two extra fields, Print "Sample Report" Title and Print Sample Header.

Check the Print "Sample Report" Title box to print “Sample Report” at the top of each page of the report.

Check the Print Sample Header box to print the sample header for each sample.

Chromatogram Report Page

The Chromatogram Report page has one extra field, Current Trace. Each type of trace can have a different set of fields associated with it, select each option from the dropdown list box and select the fields you wish to report for this type of chromatogram.
Decimal Places Page

Use this page to choose the number of decimal places to be displayed (0 – 4) for the criteria shown.

View Options

A number of options are available to change the appearance of the Browser screen, to access them select View, Options.

Spectrum Page

Peak Annotation

Decimal Places Change this value, by pressing the arrows, to change the number of decimal places displayed on peak annotation. Range 0 to 4 decimal places.

Select one of Threshold (abs) or Threshold (%) and enter a value above which peaks must be, to be annotated on the spectrum.
Accurate Mass Error Reporting

Check this box to display the difference between the observed mass and the expected mass. Check the PPM or mDa box to display the results in parts per million or millidaltons.

Figure 3.8 The Spectrum Page

Horizontal Axis

Decimal Places

Change this value, by pressing the arrows, to change the number of decimal places displayed on the horizontal axis. Range 0 to 4 decimal places.

Wavelength Label

Enter the text to appear as the label on the horizontal axis for diode array data.

Daltons Label

Enter the text to appear as the label on the horizontal axis for mass spectral data.

Peak Number

Check this box to display the Peak number before the retention time in the Spectrum header.

Retention Time

Check this box to display the Retention Time in the Spectrum header.
Process Description  Check this box to display the Process Description in the Spectrum Header.

Set DAD Axis Label  Check this box to display a label on the DAD Axis and enter the label to display in the adjacent text box.

Select all Spectra  Check this box to display all spectra for the selected well.

Default range to data  When checked, the default mass display range of a spectrum will be based upon the peaks the spectrum contains, only the mass range which actually contains data will be displayed.

If unchecked the default display range will be the actual mass range the spectrum was originally acquired over.

Chromatogram Page

![Chromatogram Page](image)

Figure 3.9 The Chromatogram Page

Peak Integration  Check this box to display the integrated baselines on the chromatogram trace.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chromatogram Purity</td>
<td>Check this box to display the chromatogram peak purity on the chromatogram peak tops.</td>
</tr>
<tr>
<td>Peak Numbers</td>
<td>Check this box to display the peak number above a peak on the chromatogram peak tops.</td>
</tr>
<tr>
<td>Found Mass</td>
<td>Check this box to display the mass of a found peak. When checked, the <strong>Spectrum Purity</strong> and <strong>Decimal Places</strong> options become available, press the arrows or enter a value for the number of decimal places to display for the found peak.</td>
</tr>
<tr>
<td>Spectrum Purity</td>
<td>Check this box to display the spectrum purity on the chromatogram peak top of a found peak.</td>
</tr>
<tr>
<td>Base Peak Mass</td>
<td>Check this box to display the base peak mass values on the chromatogram peak tops. When checked, the <strong>Decimal Places</strong> option becomes available, press the arrows or enter a value for the number of decimal places to display.</td>
</tr>
<tr>
<td>Retention Time</td>
<td>Check this box to display the retention time values on the chromatogram peak tops. When checked, the <strong>Decimal Places</strong> option becomes available, press the arrows or enter a value for the number of decimal places to display.</td>
</tr>
<tr>
<td>Threshold (%)</td>
<td>Enter a value that peaks must be above in order to be annotated on the Chromatogram.</td>
</tr>
<tr>
<td>Horizontal Axis</td>
<td>Change this value, by pressing the arrows, to change the number of decimal places displayed on the horizontal axis.</td>
</tr>
<tr>
<td>Decimal Places</td>
<td>Change this value, by pressing the arrows, to change the number of decimal places displayed on the horizontal axis.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter the text to appear as the label on the horizontal axis.</td>
</tr>
<tr>
<td>Fill Peaks</td>
<td>Check this box to fill integrated peaks in green if found (or found tentative) and red if not found. This option uses colours from the Colors page.</td>
</tr>
<tr>
<td>Fill Background</td>
<td>Check this box to fill the area under integrated peaks in the Unused color, specified on the Colors page.</td>
</tr>
<tr>
<td>Process Description</td>
<td>Check this box to display the process description on the chromatogram.</td>
</tr>
<tr>
<td>Replace DAD</td>
<td>Check this box and enter the text to use in the process description displayed on the chromatogram, this will replace the text DAD which would normally be displayed.</td>
</tr>
<tr>
<td>Set DAD Axis Label</td>
<td>Check this box to display a label on the DAD Axis and enter the label to display in the adjacent text box.</td>
</tr>
</tbody>
</table>
Default Plate Page

For autosamplers controlled by the MassLynx software a plate layout will have been defined (see the MassLynx Guide to Data Acquisition). This cannot be changed.

For autosamplers not controlled by the MassLynx software, this page is used to organise the data acquired so that it can be displayed in plate format.

**Rows**
- Enter the number of rows on the plate to be used.

**Columns**
- Enter the number of columns on the plate to be used.

**Origin**
- This is the corner of the rack that the vial grid referencing starts from. Select one of **Top Right, Top Left, Bottom Right** or **Bottom Left** from the drop down list box.
Method

This is the method of numbering the wells on a plate. There are three options:

- XY which references the vials A1, B1 etc.
- Sequential Discontinuous which numbers the vials 1, 2, 3 across a row, left to right if origin is top left, and then starts the next row from the left again.
- Sequential Continuous which numbers the vials 1, 2, 3 across a row, left to right if origin is top left, then continues to number the next row, right to left etc.

If a Gilson autosampler or Waters 2700, 2790/2795 autosamplers are used with OpenLynx then the vial referencing must be set to either sequential continuous or sequential discontinuous.

Horizontal

If the method chosen is X, Y then this box becomes enabled. It allows horizontal referencing of the plate to be a number or a letter.

Vertical

If the method chosen is X, Y then this box becomes enabled. It allows vertical referencing of the plate to be a number or a letter.

Horizontal Priority

Check this box if samples are to be acquired horizontally across the plate.

If Referencing = X, Y, Horizontal = Letter, Vertical = Number and Horizontal Priority is checked, this will result in samples being acquired in the order A1, A2, A3. If the Horizontal Priority box is not checked samples will be acquired in the order 1A, 1B, 1C etc.

If Referencing = sequential continuous or discontinuous and Horizontal Priority is checked, this will result in samples being acquired from row 1 then row 2. If the Horizontal Priority box is not checked samples will be acquired from column 1, then column 2 etc.

Colors Page

This page (Figure 3.11) allows the user to define the colors used on the Plate pane and the Chromatogram pane.

Select a color from the drop down list box.

The mass to be searched for is entered in the MassLynx Sample List or the OpenLynx Login PC.

Threshold values are on the Spectrum Test Page of the OpenLynx Setup.

Found

The intensity of the peaks is above all threshold values.

Found (Tentative)

The intensity of the peaks is above the primary threshold but below the Confirmation threshold. For more details see the Spectrum Test page in the OpenLynx Setup chapter.

Not Found

There were no peaks for the mass entered.

Not Searched

No mass was entered.

Unused

There was no sample defined for this position on the plate.

Multiple Injection

Multiple injections were made from the same well or vial.
Copy Control Page

This page (Figure 3.12) allows the user to define which information is copied to the clipboard, for use in other Windows applications.

**Plate**  
Check this box to copy Plate information for all plates in the run. This copies a series of rows containing ‘1’ for found compounds, ‘?’ for found tentative compounds, ‘0’ for compounds not found, ‘+’ if no compound was searched for, ‘-’ for unused wells.

**Sample Summary**  
Check this box to copy summary information for each Sample. The **Sample Summary** information is written to the clipboard using the settings for the Sample Summary and Results Summary in the current Report Scheme.

**Spectrum List**  
Check this box to copy details of each peak for each Sample.
Column Pages

These pages (Figure 3.13) have a similar format and allow the user to define which information is displayed in the Results Table, Fraction Results List, Elemental Composition Results List and Library Search Results List Panes. The Column Pages are:

- List Columns page
- Elemental Columns page
- Fraction Columns page
- Library Columns page.
Check the boxes next to the fields required.

Columns can be removed from the Results Table pane by clicking, with the right mouse button, on a column and selecting the **Remove Column** pop up menu that appears. Columns can only be restored by selecting them again on these pages.

**List Columns Page**

The List Columns page also shows the number of decimal places to display for the relevant fields. These can be changed by clicking, with the right mouse button, on the field and selecting the number of decimal places from the pop up menu displayed.

**Fraction Display Page**

The Fraction Display page allows the fraction collection regions on the chromatogram to be highlighted.
Show Fractions
Check this box to display the Lines and Fill Colours on the chromatogram pane.

Show on all Chromatograms
If this box is checked, the fraction collection regions are shown on all chromatograms. If this box is not checked, only the chromatograms relating to the fraction display fraction regions.

Lines
There are three sets of lines that can be displayed on the chromatogram.

For each line required, Select Line Type, choose a color from the drop down list box, select a width from the drop down list box and click on Solid, Dotted or Dashed to display the line. Click on None to hide the line.

Start Line
Shown at the start of each fraction.

End Line
Shown at the end of each fraction.
Current

A set of lines displayed at each end of the fraction selected in the Fraction Results List pane.

Fill Fraction Display

Check this box to display the region of the chromatogram that the fraction was collected from, using the fill colours described below.

First Colour

Select the required colour from the drop down list box. The area of the chromatogram that the first fraction was collected will be displayed in this colour. If there are more than two fractions collected from a chromatogram, this colour will also be used to show the 1st, 3rd, 5th, 7th etc, fractions.

Second Colour

Select the required colour from the drop down list box. The area of the chromatogram that the second fraction was collected will be displayed in this colour. If there are more than three fractions collected from a chromatogram, this colour will also be used to show the 2nd, 4th, 6th, 8th etc, fractions.

Current Colour

Select the required colour from the drop down list box. The area of the chromatogram for the fraction selected in the Fraction Results List pane will be displayed in this colour.

Double clicking, with the right mouse button, on a fraction area of the chromatogram will make the fraction the current fraction. The fraction will be selected in the Fraction Results List pane and the Current colours and lines will be used in the chromatogram pane.

Other Display Options

To Display Two Documents Simultaneously

1. Select Open from the File menu. This will display a new window over the top of the previous one.

2. Select Tile or Cascade from the window menu. This will display the two child windows in the style chosen.

3. Repeat the above steps as often as required.

To Display Two Different Views of the Same Document

Select Window, New Window, a copy of the current window is created, named “filename:2”.

Select Window, Cascade / Tile Horizontally / Tile Vertically to display this new window along side the existing document to compare results of similar searches.

To Change the Size of A Pane

To change the size of the panes on display, position the mouse pointer on the line between the two panes until the symbol appears. Alternatively select Window, Split, hold down the left mouse button and drag until the pane is the required size.
Other Menu Options

File Menu

**Load on startup**
If this option is selected, the next time the Browser is opened, the last Browser file viewed is automatically loaded. A tick mark appears next to the item when selected. Selecting this option again will turn it off.

**Send To**
If this option is selected, an e-mail message is created with the currently selected report attached to it. Enter the address to send it to and press the send button.

To view the report the recipient of the e-mail must have the MassLynx (with the OpenLynx option) or OpenLynx Browser software installed. The attachment can then be saved as normal and opened in MassLynx or the OpenLynx Browser. It can also be opened by double clicking on the report in the e-mail message. If the OpenLynx Browser software is not installed as a stand-alone program the following dialog will be displayed.

![Program Not Found dialog](image)

Click the **Locate** button and select the MassLynx directory, or type in the location of the MassLynx directory and then press the **OK** button.

**Failed Samples Options**

Select **File, Failed Samples Options**. The Failed Samples Options dialog allows you to define the parameters used when you select the **Create List of Failed Samples** option, described below.

![Failed Samples Options dialog](image)
Enable E-Mailing of Report File  
Check this box to e-mail the *.rpt file (formed when the *.olb file is processed), to the recipient specified in the E-Mail Address field. The *.olb file is processed when the user submits it to the MassLynx queue.

Create File In  
Enter the location to which you want the failed samples *.olb file to be saved.

Create List of Failed Samples  
Select this option to create a *.olb file, containing all of the samples that were marked as Not Found. The *.olb file can then be submitted to the MassLynx queue and analysed, using a different ion mode or ionisation method.

This procedure must be carried out in the following order:

1. Analyse the original sample list in electrospray positive mode.
2. Select Create List of Failed Samples from the File menu to collect the Not Found samples into a *.olb file.
3. Analyse the samples in the *.olb file in electrospray negative mode.

If necessary, repeat this procedure using APCI positive mode and APCI negative mode.

View Menu  

![Figure 3.17 The View Menu](image)

- **Refresh**  
  This option rereads the current Browser Report and updates the display information. This command should be used if the content of the Browser Report has changed as a result of processing further samples.

- **Swap List View**  
  This option allows the user to swap between the Elemental Composition Results List view and the Library Search Results List view, if both lists have been generated.

- **Toolbar**  
  If this option is selected from the View menu, then the Toolbar will be visible. A tick mark appears next to the item when selected, selecting the option again will turn it off.

- **Multiple Injections Per Vial**  
  When this option is selected the user can swap between normal plate view and multiple injection plate view.

- **Status Bar**  
  If this option is selected from the View menu, then the Status Bar will be visible. A tick mark appears next to the item when selected, selecting the option again will turn it off.
Window Menu

![Window Menu](image)

**Figure 3.18 The Window Menu**

**New Window** Selecting this item will create a copy of the current window. This is useful for displaying different views of the same document. The second document will have a ‘:2’ after the name. To change between documents, select the document required from the documents listed at the bottom of the Window menu. A tick will appear next to the document that is currently active.

**Cascade** Select this option to arrange document windows so that the title bar of each window is visible.

**Tile** Select this option to arrange open windows side by side on the screen, dividing the available space equally between the open windows so that they are all visible.

**Arrange icons** Select this option to arrange all iconized windows into rows.

The Browser Panes

As described previously the Browser screen has a maximum of seven panes, which are described below.

The Plate Pane

![Plate Pane](image)

**Figure 3.19 The Plate Pane**

The Plate Pane displays information about all the samples from the currently selected plate. The vials are color coded to indicate whether they contained a sample in which compounds were:

- Found — Light green
• Found (Tentative) — Olive green
• Multiple Sample — Pink
• Not found — Red
• Not Searched — Blue
• Contained no sample — Grey.

The default colors can be changed see "Colors Page" on page 3-18.

The currently selected vial is indicated by being shown recessed. Change the current vial by clicking on a new vial, using the vial selection toolbar buttons (arrow keys) or the arrow keys. Information about a highlighted well will be displayed in the other panes.

The current plate number can be changed by using the previous plate and next plate toolbar buttons.

If multiple samples were injected from a well, it will be colored pink and if highlighted the rest of the panes will be blank. The following message will appear in The Sample Description Pane (Figure 3.20) "Multiple samples in this batch were injected from this position. Please use the Multiple Injection Plate View". The samples can be viewed by selecting View, Multiple Injections Per Vial, or by using the Swap Plate View button from tool bar.

The appearance of a plate can be modified using the View Options command. This enables the number of rows and columns, reference labels and vial colors to be set. See View Options, on page 3-13 for more details.

The Sample Description Pane

![Sample Description Pane](image)

**Figure 3.20 The Sample Description Pane**

This pane shows a list and description of the masses found in the selected well.

**Submitter**: The *username* entered on the first page of the OpenLynx Login program.

**Sample**: The filename of the sample, as entered in the Login dialog or Sample List.

**Vial**: The plate number followed by the well column and row references.

**ID**: The sample id as entered in the Login dialog or Sample List.

**Description**: The file description, as entered in the Login dialog or Sample List.
The Fraction Collection Results Pane

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Original Target</th>
<th>Ion M</th>
<th>Start Time</th>
<th>End Time</th>
<th>Collection Site</th>
<th>No. Of Tubes</th>
</tr>
</thead>
<tbody>
<tr>
<td>50.0000</td>
<td>50.0000</td>
<td>+ve</td>
<td>1.57</td>
<td>1.66</td>
<td>FRACTION5:008</td>
<td>1</td>
</tr>
<tr>
<td>50.0000</td>
<td>50.0000</td>
<td>+ve</td>
<td>1.75</td>
<td>1.84</td>
<td>FRACTION5:007</td>
<td>1</td>
</tr>
<tr>
<td>50.0000</td>
<td>50.0000</td>
<td>+ve</td>
<td>1.66</td>
<td>2.08</td>
<td>FRACTION5:008</td>
<td>1</td>
</tr>
<tr>
<td>50.0000</td>
<td>50.0000</td>
<td>+ve</td>
<td>2.10</td>
<td>2.26</td>
<td>FRACTION5:009</td>
<td>1</td>
</tr>
<tr>
<td>50.0000</td>
<td>50.0000</td>
<td>+ve</td>
<td>2.34</td>
<td>2.85</td>
<td>FRACTION5:010</td>
<td>1</td>
</tr>
<tr>
<td>50.0000</td>
<td>50.0000</td>
<td>+ve</td>
<td>3.01</td>
<td>3.53</td>
<td>FRACTION5:011</td>
<td>1</td>
</tr>
<tr>
<td>50.0000</td>
<td>50.0000</td>
<td>+ve</td>
<td>3.55</td>
<td>4.00</td>
<td>FRACTION5:012</td>
<td>1</td>
</tr>
</tbody>
</table>

Figure 3.21 The Fraction Collection Results Pane

This pane shows a list of fractions collected and will not be displayed if fraction collection was not performed.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Original Target</th>
<th>Ion M</th>
<th>Start Time</th>
<th>End Time</th>
<th>Collection Site</th>
<th>No. Of Tubes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To change the width of a column

The width of the columns can be changed, by positioning the mouse pointer on the heading between two columns until the + symbol appears, and then clicking and dragging the column separators in the list header.

The Results Table Pane

<table>
<thead>
<tr>
<th>Peak Num</th>
<th>Compound</th>
<th>Mass</th>
<th>Function</th>
<th>Time</th>
<th>Trace</th>
<th>%Total Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>X 1</td>
<td>1: M/S (ES+)</td>
<td>1.92</td>
<td>1:TIC</td>
<td>6.77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X 2</td>
<td>1: M/S (ES+)</td>
<td>2.65</td>
<td>1:TIC</td>
<td>15.13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✓ 3</td>
<td>Found</td>
<td>3.05</td>
<td>1.00</td>
<td>0.00</td>
<td>95.71</td>
<td></td>
</tr>
<tr>
<td>✓ 4</td>
<td>Found</td>
<td>3.66</td>
<td>1:TIC</td>
<td>1:...</td>
<td>79.10</td>
<td>3:...</td>
</tr>
<tr>
<td>X 5</td>
<td>1: M/S (ES+)</td>
<td>7.37</td>
<td>DAD: TIC</td>
<td>7.22</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3.22 The Results Table Pane

For the analysis of complex libraries where on-line chromatography is used, the yes/no answer is supplemented with a results table. This table is split into the following columns:

Peak Number  This lists the number of compounds that have been detected using the parameters specified in the OpenLynx Setup. Each detected compound has its own peak number.
Chapter 3 OpenLynx Browser

If an entered mass is detected in a particular Peak Number then this column will display 'Found'.

If an entered mass is detected in a particular spectrum then this column will display the mass followed by the % Purity. If no compounds were found this will be blank.

This column states the MS function and ionisation technique in which the chromatographic peak was detected.

The retention time of the spectrum in decimal minutes.

Description of the chromatogram used to locate this spectrum. This may be blank if a specific retention time was used to locate spectrum. The information listed here can be, amongst others, TIC, DAD or a mass chromatogram.

The area of a particular peak represented as a percentage of the total area of all the peaks detected using a particular trace.

The height of a particular peak.

The retention index of a particular peak.

The measure of the hydrophobicity of a particular peak.

If quantification was selected this column will display the concentration of the detected compound. '….' will be displayed if the concentration was not calculated for this peak.

This column will display the Concentration, multiplied by a User Factor defined in the sample list, or the Factor specified on the Quantify page of the OpenLynx Setup. The Factor can be a user-specified number, or the number of nitrogens in the chemical formula, depending on the option selected. '….' will be displayed if the amount was not calculated for this peak.

If a good quality spectrum was found the State field contains the message OK. If the State was not found to be OK then the State field may contain one or more of the following messages. Overloaded, Noisy or Too few peaks.

The width of the columns can be changed, by positioning the mouse pointer on the heading between two columns until the + symbol appears, and then clicking and dragging the column separators in the list header.

Columns can be removed from the display. Right Click on a column heading and select Remove Column from the pop up menu displayed.

Note: Columns can only be restored from the List Columns dialog.
To Select a Result

The result highlighted will be displayed in the Spectrum, Chromatogram and Sample Description panes. To select another result to view click on any part of the row of the result required, or use the arrow keys to page up and down the list of results.

The Spectrum Pane

![Figure 3.23 The Spectrum Pane](image)

This pane displays the Mass Spectra of the index entry highlighted in the Results Table pane.

When a new sample is selected the first spectrum in each of the acquisition functions is displayed. Individual spectra can be displayed by selecting the corresponding Peak Number field in the Results Table pane.

Multiple entries can be displayed by holding down the Ctrl key and clicking on the required entries or holding down the Shift key and clicking on the last entry in a block.

The Spectrum Pane will appear blank if no sample is currently selected or if the current size of the pane is not large enough to show all the spectra currently required.

The text in red on the left-hand side of the pane is the mass spectrum retention time.

The text on the right hand side of the pane shows the acquisition function type and ionisation mode followed by the absolute intensity of the largest peak in the spectrum, on the next line.

Altering the Range of the Horizontal Axis (Zoom) With the Mouse

Press at one end of the region of interest, and without releasing the button, drag the mouse horizontally to the other end. As you drag the mouse you will see a "rubber band" stretched out to indicate the range you have selected; don't go beyond the bounds of the axis. When the mouse button is released the selected range will be re-displayed to fill the current window.

This operation can be repeated as often as required.

Pressing the toolbar button will restore both the Spectrum and Chromatogram display to the default range.
The Elemental Composition Results List / Library Search Results List Pane

This pane will display either the Elemental Composition Results List or the Library Search Results List, depending on the information selected in the OpenLynx Setup and the view selected. If both Elemental Composition and Library Searching results have been obtained then press the toolbar button or select Swap List View from the View menu to switch between the two views.

To Change the Width of a Column

The width of the columns can be changed, by positioning the mouse pointer on the heading between two columns until the + symbol appears, and then clicking and dragging the column separators in the list header.

The Elemental Composition Results List

<table>
<thead>
<tr>
<th>Mass</th>
<th>Calculated Mass</th>
<th>mDa</th>
<th>PPM</th>
<th>DBE</th>
<th>Formula</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>505.1844</td>
<td>505.1844</td>
<td>-0.0</td>
<td>-0.1</td>
<td>15.5</td>
<td>C25 H29 N6 O 52</td>
<td>3</td>
</tr>
<tr>
<td>505.1844</td>
<td>505.1843</td>
<td>0.1</td>
<td>0.3</td>
<td>7.0</td>
<td>C19 H31 N5 O 9 S</td>
<td>10</td>
</tr>
<tr>
<td>505.1844</td>
<td>505.1849</td>
<td>-0.5</td>
<td>-1.0</td>
<td>21.5</td>
<td>C25 H21 N10 O2</td>
<td>19</td>
</tr>
<tr>
<td>505.1844</td>
<td>505.1849</td>
<td>-0.5</td>
<td>-1.0</td>
<td>16.0</td>
<td>C27 H27 N3 O7</td>
<td>15</td>
</tr>
<tr>
<td>505.1844</td>
<td>505.1837</td>
<td>0.6</td>
<td>1.3</td>
<td>19.5</td>
<td>C33 H29 O3 S 6</td>
<td>6</td>
</tr>
<tr>
<td>505.1044</td>
<td>505.1036</td>
<td>0.8</td>
<td>1.6</td>
<td>16.5</td>
<td>C25 H25 N6 O6</td>
<td>17</td>
</tr>
<tr>
<td>505.1044</td>
<td>505.1054</td>
<td>-1.0</td>
<td>-2.0</td>
<td>3.5</td>
<td>C13 H29 N0 O13</td>
<td>20</td>
</tr>
<tr>
<td>505.1844</td>
<td>505.1856</td>
<td>-1.2</td>
<td>-2.4</td>
<td>12.0</td>
<td>C27 H27 N9 O8 S</td>
<td>11</td>
</tr>
</tbody>
</table>

Figure 3.24 The Elemental Composition Results List

This displays the results of the Elemental Composition processing (defined in the OpenLynx Setup) for the peak number highlighted in the Results Table pane.

Mass

The entered mass.

Calculated Mass

The calculated mass for the formula shown in the Formula column.

mDa

The difference between the calculated mass and the entered mass in milliDaltons.

PPM

The difference between the calculated mass and the entered mass in parts per million.

DBE

The double bond equivalent for the formula shown in the Formula column.

Formula

A suggested formula for the entered mass.

Score

A number showing the relative fit of a calculated isotope pattern for the suggested formula compared with the actual isotope pattern.

Clicking on the score column header rearranges the entries in the table into score order. Clicking on the mDa column header sets the entries back to the original order.
The Library Search Results List

This displays the results of the Library Search processing (defined in the OpenLynx Setup) for the peak number highlighted in the Results Table pane.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Name</th>
<th>Forward</th>
<th>Reverse</th>
<th>Mass</th>
<th>Filter 1</th>
<th>Filter 2</th>
<th>Flags</th>
</tr>
</thead>
<tbody>
<tr>
<td>5009</td>
<td>2,4,6-DIMETH.</td>
<td>392</td>
<td>427</td>
<td>505</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>5010</td>
<td>COBALT, BIS(1...)</td>
<td>280</td>
<td>330</td>
<td>505</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>5011</td>
<td>2H,2H-PORP</td>
<td>245</td>
<td>285</td>
<td>508</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>5015</td>
<td>SILANE, OBE</td>
<td>233</td>
<td>233</td>
<td>520</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>5004</td>
<td>SILANE, (17.0...)</td>
<td>136</td>
<td>228</td>
<td>504</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
</tbody>
</table>

The Chromatogram Pane

This pane displays the processed chromatogram of the Peak Number entry highlighted in the Results Table pane.

Figure 3.25 The Library Search Results List

Figure 3.26 The Chromatogram Pane
The current chromatogram peak is displayed in a darker color to indicate it is the current peak.

If a target mass is found within a chromatogram peak the color of that peak is the found color, in this case green. Found tentative peaks will also be displayed in this colour. Annotated to this peak is the time, mass found 301, % total purity 37%, and the retention time in this case 3.05.

The text in red on the left hand side of the pane is the chromatogram description.

The text on the right hand side of the pane is an indication of the maximum intensity of the chromatogram.

**Altering the Range of the Horizontal Axis (Zoom) With the Mouse**

Click at one end of the region of interest, and without releasing the button, drag the mouse horizontally to the other end. As you drag the mouse you will see a "rubber band" stretched out to indicate the range you have selected; don't go beyond the bounds of the axis. When the mouse button is released the selected range will be re-displayed to fill the current window.

This operation can be repeated as often as required.

Pressing the toolbar button will restore both the Spectrum and Chromatogram display to the default range.

**Viewing Other Chromatograms**

Each entry in the results table can have one or more chromatograms associated with it. To view another chromatogram page down using either the scroll bar or the arrow keys.
Chapter 4 OpenLynx Manager
Contents

Figures.......................................................................................................................................... 4-2
Overview ....................................................................................................................................... 4-3
The OpenLynx Manager Dialog ................................................................................................. 4-3
The File Menu ............................................................................................................................. 4-4
  Report Location ....................................................................................................................... 4-4
  Print Report Format ................................................................................................................ 4-5
The Administration Menu ............................................................................................................ 4-5
  Set Bed Layout ....................................................................................................................... 4-5
  Clear Job Queue .................................................................................................................... 4-6
  Reset Bed Status ................................................................................................................... 4-6
E-Mail ......................................................................................................................................... 4-7

Figures

  Figure 4.1 The OpenLynx Manager dialog ............................................................................... 4-3
  Figure 4.2 The Select OpenLynx Report Destination dialog .................................................. 4-4
  Figure 4.3 The Print Report Format dialog ............................................................................. 4-5
  Figure 4.4 The Select Bed Layout dialog ................................................................................. 4-5
  Figure 4.5 The Choose Profile dialog .................................................................................... 4-7
Overview

The OpenLynx Manager allows the user to view batches of samples, delete batches from the queue and change autosampler bed layouts.

In order to login samples OpenLynx Manager must be open on the MSPC, in addition to OpenLynx Login. OpenLynx Login to be open on the Login PC.

The OpenLynx Manager Dialog

To access the OpenLynx Manager dialog select OpenLynx, OpenLynx Manager from the MassLynx Shortcut Bar.

Jobs

This is a list of jobs submitted to the Mass Spectrometer.

Jobs in Queue

This is the number of single or multiple sample jobs in the queue. One OpenLynx Login is one job.

Current Job

This is the name of the job currently being acquired.

Instrument State

This is the current state of the mass spectrometer, running, acquiring etc.

The field at the bottom of the dialog shows the type of login selected. 100 positions (Single Shot login) is the number of vial positions in the autosampler rack. If plate login was selected this would show the number of plate positions. See Set Bed Layout, on page 4-5 for more details.
The File Menu

Report Location

The Report Location dialog allows the manager to define the location to which report files will be written. To access the dialog select File, Report Location.

![Select OpenLynx Report Destination dialog](image)

**Primary**
Enter the full path of the primary report location.

**Secondary**
Enter the full path of a secondary report location. Reports are written here if the Primary location is unavailable.

**Copy**
This location could be used for writing an archive copy or writing to A:

**Enable e-mailing of reports**
Check this box to enable the e-mail option on the LoginPC. If this box is not checked the e-mail option will not appear on the LoginPC dialog.

**Mail copy of all reports to**
Enter the e-mail address to which you want to e-mail a copy of the report. If OpenLynx Global Server is enabled then the URL of the results will also be sent. For more information on e-mailing reports, see E-Mail, on page 4-7.

**Signature to be added to end of reports**
Enter text to be added to the bottom of e-mailed reports, e.g. name, job title, and phone number.
Generate report summary text files

Check this box to copy processed information to a text file. This will generate a file with the same name as the report, with a .txt extension, and put it in the same directory as the report. This report will also be e-mailed if the e-mail option has been selected.

Print Report Format

This allows the manager to define when a report will be printed and which report format to use. To access the dialog select Print Report Format from the File menu.

![Print Report Format dialog](image)

**Print OpenLynx reports upon Job completion**

Check this box to print the report as soon as it is complete.

**Default report scheme**

If the report scheme on the Walkup page of the OpenLynx Setup has been left blank then the report scheme defined here will be used. Enter a report scheme name, including the full path. For more information on Report schemes, see the OpenLynx Browser chapter.

The Administration Menu

Set Bed Layout

The Set Bed Layout dialog allows the user to select the type of bed to use. To access this dialog select Set Bed Layout from the Administration menu.

![Select Bed Layout dialog](image)

**Use current MassLynx autosampler bed layout**: Check this box to use the current bed layout defined in MassLynx. This option is for Gilson, Waters 2700, Waters 2790, Waters 2767, Waters 2747 and PAL CTC autosamplers only.
**Use entire bed for plate login:** - For the Gilson, Waters 2700, Waters 2790 and CTC PAL autosamplers plates can be marked for OpenLynx plate login from the MassLynx Software, to do this for the Gilson, Waters 2700 and Waters 2790.

1. For the Gilson autosampler select **Bed Layout Editor** from the **Gilson Tools** menu on the **Inlet Editor**. (See Gilson Autosamplers - Advanced Options in the Guide to Data Acquisition).
   
   For the Waters autosamplers select **Waters2700/2790/2795/2747/2767, Bed Layout** from the menu on the **Inlet Editor**. (See the Inlet Control Guide).

2. Click on the **Modify Bed Layout** tab.

3. Click on the required plate to display the **Plate Position and Type** dialog.

4. Check the **OpenLynx plate login** box to define this plate for plate login.

5. Press **OK**.

6. Repeat for each plate required.

For the CTC PAL autosampler:

1. For the CTC PAL autosampler select **OpenLynx Plate Login** from the **Plate Login** menu on the **Inlet Editor**. (See CTC PAL Autosampler - Using the CTC PAL Autosampler with OpenLynx in the Guide to Data Acquisition).

2. If the plate required is labeled **Disabled** double click on the tray number. Disabled changes to **Enabled**, enabled trays can be used for plate login.

Plates defined in this way can only be used for plate login; other plates can be used for single shot login. Check the **Use entire bed for plate login** box to override these settings and use the entire bed for plate login.

**Disable Autosampler Pause** - When a batch is being logged in on the Login PC the autosampler is paused to prevent injury when putting the plate onto the rack. Check this box to disable this feature. For safety reasons Micromass recommend that this option not be used.

**Number of available sample positions** - Enter the number of wells on the plate being used. Use this option if a Gilson, Waters 2700, Waters 2790 or CTC PAL autosampler is not being used.

---

**Clear Job Queue**

Select this option to delete all batches submitted to the mass spectrometer. A message will appear asking for confirmation of this action, select **Yes** to clear the queue. The Job Queue on the MassLynx Screen will not be cleared; this will have to be done from within the main MassLynx program.

**Reset Bed Status**

Select this option to reset communications with the OpenLynx Login program. A message will appear asking for confirmation of this action, select **Yes** to reset the bed status.

**Do not use this under normal conditions, as it may produce unexpected results.**
E-Mail

To e-mail reports it is recommended that an e-mail account is set up for the MSPC, from which to send the reports.

If the **Enable e-mailing of reports** box is checked, on Figure 4.2 The Select OpenLynx Report Destination dialog (page 4-4), then the MSPC e-mail account must be open to send the reports.

It is recommended that e-mail is opened before the OpenLynx Manager is started. If e-mail is not open and the **Enable e-mailing of reports** box is checked, you will be prompted to open it. The **Choose Profile** dialog will be displayed, press **OK** to continue.

![Figure 4.5 The Choose Profile dialog](image)

The usual e-mail login dialog will then be displayed, enter details as normal and press **OK**.

If **Cancel** is pressed, on either the Choose Profile or Login dialog, then e-mail will not be opened and no reports will be sent.
Chapter 5 OpenLynx Login
Chapter 5 OpenLynx Login

Contents

Overview ....................................................................................................................... 5-3
The OpenLynx Login Dialog ...................................................................................... 5-3
The Status Bar .............................................................................................................. 5-3
QC Setup .................................................................................................................... 5-4
Reset Login Position ............................................................................................... 5-6
Sample Login ............................................................................................................. 5-6
  Plate Login .............................................................................................................. 5-7
  Creating Delimited Files ..................................................................................... 5-11
The File Menu ........................................................................................................... 5-12
  Methods ............................................................................................................... 5-12
  Status ................................................................................................................... 5-13
  HPLC File Location ............................................................................................. 5-13
  Options ................................................................................................................ 5-14
The Security Menu .................................................................................................... 5-16
  Swap Mode ......................................................................................................... 5-16
Mode ......................................................................................................................... 5-17
  Wizard .................................................................................................................. 5-17
Timeout ..................................................................................................................... 5-19

Figures

Figure 5.1 The OpenLynx Login dialog................................................................. 5-3
Figure 5.2 The QC Options dialog ....................................................................... 5-4
Figure 5.3 The OpenLynx Login dialog 1............................................................. 5-7
Figure 5.4 The OpenLynx Login dialog 2............................................................. 5-8
Figure 5.5 The OpenLynx Login dialog 3............................................................. 5-8
Figure 5.6 The OpenLynx dialog 3 - Single Shot Login ....................................... 5-9
Figure 5.7 The OpenLynx Login dialog 4............................................................. 5-10
Figure 5.8 The OpenLynx dialog 5 ..................................................................... 5-11
Figure 5.9 The Select OpenLynx Method Directory dialog................................. 5-12
Figure 5.10 The Select OpenLynx Status Directory dialog ................................. 5-13
Figure 5.11 The Select HPLC Description File Directory dialog ......................... 5-13
Figure 5.12 The OpenLynx Options dialog.......................................................... 5-14
Figure 5.13 The OpenLynx Login Unknown user name dialog .......................... 5-16
Figure 5.14 The OpenLynx Access Security Login dialog ................................... 5-17
Figure 5.15 The Single Page Login dialog........................................................... 5-18
Figure 5.16 Warning dialog shown when whole plate login is attempted under the single page login .............................................................................................................. 5-18
Figure 5.17 The Sample Login dialog ................................................................. 5-19
Figure 5.18 Missing Fields Warning dialog ......................................................... 5-19
Figure 5.19 The Edit Value dialog ...................................................................... 5-20
Overview

The OpenLynx Login program allows users to log in samples for analysis by the OpenLynx system.

The OpenLynx Login Dialog

The OpenLynx Manager must be running on the MSPC before the OpenLynx Login program is started.

To start OpenLynx Login, double click on the shortcut to OALogin icon on the desktop or press the Start button, choose Programs, OpenLynx Login and then OpenLynx Login. See chapter 1 for information on how to set up a shortcut.

Figure 5.1 The OpenLynx Login dialog

Information about the current login status, as well as the time that it will take to complete analysis of all the samples currently in the queue is displayed in the status bar and on the message bar above the status bar. It is optional whether the Login QC Sample (see page 5-4) button is displayed.

In Administrator mode, all the menu options are enabled, when the method file and status file directories have been defined the Administrator should swap to secure mode.

In Secure mode, the only options available are the Login Samples button, allowing users to login samples, and the Swap Mode on the Security menu allowing the Administrator to swap back to administrator mode.

The Status Bar

The Status bar appears at the bottom of the OpenLynx Login dialog. When the system is running correctly it will display "Press button to login samples" followed by the number of Jobs waiting in the queue. If this message does not appear check the following:

1. The OpenLynx Manager is running.
2. An OpenLynx Status file (*.ols) has been opened.
3. If 1 and 2 are correct select **Reset Bed Status** from the OpenLynx Manager **File** menu.

## QC Setup

QC checking is used to check that the mass spectrometer and HPLC system are working correctly and to ensure the consistency of data acquired. A QC sample with a known retention time and peak intensity is acquired and the results compared to the values entered on the Quality Control page in the OpenLynx Setup.

To use the Quality Control options in OpenLynx Login the **QC Required** box on the Quality Control Page in OpenLynx Setup must be selected.

To access the **QC Options** dialog select **File, QC Setup**.

![Figure 5.2 The QC Options dialog](image)

**QC On**  
Check this box to perform QC checking. The other fields in the dialog will be enabled.

**QC Login**  
Checking this box will enable the **Login QC Sample** button on the main login screen. The button is not displayed if the box is unchecked.

**Multi Probe**  
Check this box if a MUX system is being used. Selecting this checkbox enables the **Probe** field. If this box is checked all the **Vial Position** and **Mass** edit boxes will be enabled.
Probes

Enter the number of probes on the MUX system. The corresponding number of Vial Position and Mass fields will be enabled.

Timed QC

Check this box to perform QC checking at a defined time. A timed QC process will wait on the queue until the Time defined before acquiring data.

The Time field allows the start time for the timed QC acquisition to be defined. Pressing the buttons will increase or decrease the time by one hour. To change the minutes click on the minute's part of the display, pressing the buttons will now increase or decrease the time by one minute.

QC Sample

Check this box to perform QC checking after the defined number of Batches. E.g. if 2 is entered two OpenLynx batches will be acquired and processed and then the QC sample(s) will be acquired and checked.

OpenLynx Setup File

Select the OpenLynx Setup file from the drop down list box. The file selected should contain the Retention Time and Area (on the Quality Control page) of the QC sample. Note: The QC Required box must be checked on the Quality Control page of the selected OpenLynx Setup file for QC checking to be performed.

Action on Error

The Action on error field allows the users to define what happens to a batch if an error occurs. Select the required option from the dropdown list box.

- Ignore Error Ignore the error and continue with the acquisition.
- Suspend This Batch Pauses the current batch and continues with the next batch in the MassLynx Queue.
- Suspend All Batches Pauses all batches.
- Delete This Batch Deletes the current batch from the queue and continues with the next one.

If no action is chosen then Ignore Error is used.

User Name

Enter your username.

Base File Name

Enter the text to use as the Base File Name. When a QC sample is acquired and processed a *.RAW and a *.rpt file will be produced.

- For non-MUX systems, the name of the files will be the Base File Name followed by the Job Number.RAW and rpt.
- For MUX systems, the name of the files will be the Base File Name followed by the Job Number followed by –n where n is the Stream Number.RAW and rpt.

The Job Number will automatically be incremented by 1 when the QC sample is next checked.

Job Number

This field is display only and shows the current job number.
**Reset Job Number**

Press this button to reset the Job Number to 1.

**E-mail User**

Check this box to automatically e-mail the *.rpt file to the address entered in the **E-mail Address** box.

**Vial Position**

The full vial location must be entered in the correct format for the plate being used i.e. the plate position in the rack and the vial position in the plate. For MUX systems the plate number should be the same in each of the eight edit boxes and the vial numbers need to be sequential.

**Mass**

Enter the mass to look for. If the mass is not found then the QC test will fail. For MUX systems a different mass can be entered for each stream.

**Reset Login Position**

Normally when an OpenLynx batch is entered on the Login PC, the software indicates where the vials or plates should be placed. This position is immediately after the previous batch e.g. if the first batch occupies positions 1 to 20 on a plate, you are prompted to put the first sample of the next batch in position 21. To reset this position back to 1, select **File, Reset Login**.

If position/plate 1 is defined as the location of the QC sample(s) the software will use the next available free position.

**Sample Login**

There are two types of Sample Login:

- **Plate Login** where data is prepared in spreadsheet or text file form and imported into the Login program. This option is available for Gilson/Waters 2700, Waters 2790/2795, Waters 2747, Waters 2767 and CTC PAL autosamplers.

- **Single Shot login** where data for each sample can be entered manually or imported from a tab delimited text file.

**Default Data**

It is recommended that all data fields are filled with the correct information, but in some cases fields can be left blank and OpenLynx will fill them with default data.

- **Well**
  This will default to next available vial position.

- **Sample ID and MS Data Name**
  These will default to the Job name, plus an incremental number.

- **MS Injection Volume**
  The injection volume can be specified. If it is not it is taken from the OpenLynx Method.
Plate Login

To Log in Samples

The information displayed in the following dialogs may vary according to the parameters defined in the OpenLynx Setup program.

1. Press the **Login Samples** button.

![Figure 5.3 The OpenLynx Login dialog 1](image)

2. If the user is a new user, type in your **username** and press **Enter**. If user account creation is enabled a message will appear asking if a new account should be created, press the **Yes** button. If user account creation is disabled a message will appear informing the user that an existing name should be used or that the Administrator should be contacted to add a new name to the list. See Options, on page 5-14 for details.

   If the user is not a new user either type in your **username** and press **Enter**, or select your **username** from the drop down list box.

   The Job ID will be assigned by OpenLynx. For more information on setting up Job Names see Options, on page 5-14.

   If the e-mail option is enabled (see Options, on page 5-14) and you require a report to be sent, check the **E-mail results to address** box and enter an e-mail address.

   If the single sample option is enabled (see Options, on page 5-14) and the **Single Sample Login Using a File** check box is checked, multiple sample single shot login, using a text delimited file containing the sample details, is enabled.

   The **Sample Holders** list box is available so the type of plate required can be selected by clicking on the particular entry in the box. This list box is not present if all plates are the same. The grayed out field below the list box displays a description of the plate selected.

   Press the **Next** button.
Figure 5.4 The OpenLynx Login dialog 2

3. The current method description appears in the box on the right of the dialog, if this is the method you require press the **Next** button. If another method is required, select the required method and press the **Next** button.

Figure 5.5 The OpenLynx Login dialog 3

4. If the check box **Single Sample Login Using a File** has been checked in Figure 5.3 then the above dialog is displayed.

Data copied onto the clipboard, from a spreadsheet or a text file, can be pasted into the dialog by pressing the **Paste from Clipboard** button.

Data saved in files can be imported into the dialog by pressing the **Read from Delimited File** button, and selecting a file from the browser displayed. See Creating Delimited Files page 5-11 for more information.

To clear all information from the dialog, press the **Clear Sample information** button.

When all sample information has been entered, press the **Next** button.
5. If Single Sample Login Using a File is left unchecked (see Figure 5.3) the above dialog is opened. Sample Information is put in by hand. The fields displayed in this dialog are selected in the OpenLynx Setup Walk-up page (see Chapter 2).

Enter the number of samples and the sample information for the first sample. If there is more than one sample the screen will change to display \[ \llq \ll \ll \lll 1 \lll 10 \llr \rr \rrr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \rr \r
Chapter 5 OpenLynx Login

Figure 5.7 The OpenLynx Login dialog 4

Run Time
Set this value to the time in minutes that the method will run from the point of injection.

Column Heaters
Enter the temperature in degrees centigrade for the column heater(s). This will be in the Temperature field for the Waters 2690 and the Left and/or Right fields for the HP1100.

Injection Volume (µl)
Enter the volume of the sample to inject.

If you wish to operate in isocratic mode then you should ensure the timetable has one entry for time 0.00.

To add a gradient, type in a time, flow and percentage in the relevant boxes and press the toolbar button. **Note:** The first entry must have a time of 0.

To delete a single gradient, click on a time in the list and press the toolbar button.

To delete all entries, press the toolbar button. This button is only available when there are entries in the timetable.

To modify a gradient, select the required entry in the timetable. The values will then be displayed in the edit boxes above the timetable, and can be altered as appropriate. Once changed, press to re-enter the values into the timetable. However, if you modify the time value such that it does not correspond to any existing entry in the timetable pressing will result in a new entry being created in the timetable.

The gradient parameters that you can set are:

**Time**
The time at which you wish the following parameters to be attained during a method run.

**Flow Rate**
Enter the total flow rate of all the solvent channels.
%A
This field cannot be changed, it displays the remaining percentage when the values in the %B, %C and %D fields have been added together.

%B
The percentage of solvent B you wish to attain at the given time.

%C
The percentage of solvent C you wish to attain at the given time.

%D
The percentage of solvent D you wish to attain at the given time.

Acquire Diode Array Data
Check this box to acquire diode array data.

When all information has been entered, press the Next button.

Figure 5.8 The OpenLynx dialog 5

7. Place the samples in the position indicated and press the Finish button. The samples will then be submitted for analysis. OpenLynx will return to the Login screen with the status bar updated with the number of jobs waiting and the name of the submitter of the current job.

8. Press the Back button on any screen to go back to the previous screen, if for example some information needs amending. Press the Cancel button to cancel the login and return to the Login screen.

Creating Delimited Files

Typically, with Plate Login, large numbers of samples will be processed in one run. To save typing in information for each sample, text files are created using spreadsheets or text editors and imported into the Login program.

These files can be created in Excel and saved as a Text (tab delimited) (*.txt) file, or in any Windows text editor e.g. Notepad. The following is a list of tips for creating these files.

Spreadsheets

- Only single pages can be saved as text files, so although workbooks can have more than one page, each page must be saved as a different text file.
- Save as tab delimited file.
• The spreadsheet must be closed before importing the text file. If the spreadsheet is not closed previous versions of the file will be imported.

• Define cell format as Text, to prevent the spreadsheet converting numbers with ":" or "/" in them into times and dates.

Text Editor

• Enter field data and Tab to the next field.

Both Spreadsheets and Text Editor

• The files should contain field data only, no column headings.

• The Well numbering should correspond to that defined for your Autosampler, see the Advanced Options section of the Controlling Inlet Systems and Autosamplers chapter of the MassLynx NT Guide to Data Acquisition for more details.

If Well numbers are entered as 1, 2, 3, 4 etc, the first plate will be filled and the further samples will be placed on the next plate.

If Well numbers are entered as 1:n, 2:n or 1:n,n, 2:n,n etc., samples prefixed with 1: will be placed on plate 1, samples prefixed with 2: on plate 2 etc.

The File Menu

Methods

This allows the Administrator to define the location of the method files.

To Select the Method Files Directory

1. Select Methods from the File menu.

2. Select one of the method files (*.olp) and press the Open button, or double click on one of the method files.

All method files in the directory will be available to the OpenLynx Login program.
Status

This allows the manager to define which OpenLynx status file will be used.

To Select the OpenLynx Status file

1. Select Status from the File menu.
2. Select the OpenLynx Status file (*.ols) and press the Open button, or double click on the OpenLynx Status file. There should only be one OpenLynx Status file.

HPLC File Location

To Select the HPLC File Location

1. Select File, HPLC File Location. The Select HPLC Description File Directory dialog is displayed.
2. Locate the required directory and select a HPLC file and Click **Open**, or double click on one of the files.

**Options**

This allows the manager to define Job names and to allow the e-mail option on the Login dialog.

![OpenLynx Options dialog](image)

**Default Job Identifier**

- **Base Job Name**
  
  By default, Job names are based on the **username** with a Job number appended to it, leave this box blank to continue to name jobs in this way. If you require Jobs to be named differently, enter the Job Name text in this box.

- **Next Job Number**
  
  By default, Job names are based on the **username** with a Job number appended to it. When a job has been submitted this number is incremented. If you require Job numbers to start at a specified number or wish to restart numbering change the number in this box.

- **Allow user to change job identifier**
  
  Check this box to allow the user to change the automatically generated **Job ID** on the Login screen.
Default Data File Name

By default, the MS Data Name (entered in the Sample List or on the Login PC) is used as the file name. Alternatively the Sample ID or a user defined naming system can be used.

**Use Sample ID for file name**

Allows use of the Sample ID as the file name.

**Use Incremental File Naming**

Enables the two fields below it. Allows the use of another file naming system, instead of the MS Data Name.

**Base File Name**

Enter the text to be used as the base file name.

**Increment Number**

Enter the number to start from in the file name.

E-mail

The e-mail option must be enabled in the OpenLynx Manager and e-mail open on the MSPC for reports to be sent.

**Enable e-mailing of user report**

To enable the e-mail option on the Login dialog, check this box. If not checked then the e-mail option does not appear on the dialog.

Login Screen appearance

**Title Bar Text**

Text entered here is displayed on the title bar of the Login dialog.

**Login Button Text**

Text entered here is displayed on the login button of the Login dialog.

**Batch Identifier Text**

Text entered here replaces the text ‘Job ID’ displayed on the Login dialog.

HPLC Pump

**User defined HPLC gradient**

If users are allowed to define a gradient for the LC method when logging on a sample, check this box and select the type of HPLC pump, from the drop down list box.

Username

**Allow user to create own user name**

Check this box to allow users to create new user accounts on the Please enter your name page. If checked a user can enter a new name and when the Next button or Return is pressed the Unknown user name dialog is displayed.

If the above checkbox is unchecked no new user accounts can be created. A message is displayed informing the user that an existing name should be used or that the Administrator should be contacted to add a new name to the list. The Administrator must then check this box, add the user and then uncheck it again to disable user account creation on the Login PC.
Single Sample File Login

Allow single sample file login

Check this box to allow single sample information to be pasted from the clipboard or read from tab delimited file, as for plate login.

Printing of OpenLynx Report File

Enable User print Control

Provides an option to Print OpenLynx Report on the opening Login page.

Sort Methods By

The radio buttons with in this group box allow the methods on the method selection page (page 5-8) in the wizard to be sorted.

No Sort

Methods will be listed in a random order. Selected by default.

Name A-Z

Methods will be listed alphabetically with A first.

Name Z-A

Methods will be listed alphabetically with Z first.

Modified Earliest

Methods will be listed in order of modification time with the earliest first.

Modified Latest

Methods will be listed in order of modification time with the latest first.

The Security Menu

Swap Mode

This allows the administrator to swap between Administrator mode and Secure mode.

In Administrator mode, all menu options are enabled. In Secure mode, the only options available are the Login Samples button, allowing users to login samples, and the Swap Mode on the Security menu allowing the Administrator to swap back to administrator mode. The user cannot access any options on the Login PC or on the Desktop.

Selecting Swap Mode from the Security menu will display the Open Access Security dialog.
Figure 5.14 The OpenLynx Access Security Login dialog

Enter **Name** and **Password** and press **OK** to swap mode.

**The Initial Password**

The initial **Name** is “Admin” and the **Password** is blank, i.e. enter “Admin” in the **Name** field and press **OK**.

**To Change the Password**

1. Enter **Name** and **Password**.
2. Enter **New Password** and press the **New** button.
3. Enter the new password in the **Password** field and press **OK**.

**Mode**

**Wizard**

This option is selected by default, deselecting it brings up a one-page login dialog box that can be used instead of the wizard to login single shot samples. Reselecting this option returns the user back to the wizard mode. All the features on the single page login dialog are on the wizard pages as well.
Figure 5.15 The Single Page Login dialog

**Login Information**

- **Your Name**: Enter your username.
- **Job ID**: Box showing the job ID.
- **Method**: Enter the method to be used for the processing.
- **Description**: Box showing a description of the method selected. The text here is that entered in the Description field of the Walk-Up page of OpenLynx Setup (see Chapter 2).
- **E-mail results to address**: Enter the e-mail address to which the results should be sent.
- **Sample Holder**: This will display single shot plates and plate login plates, but if an attempt to select a whole plate login the warning shown in Figure 5.16 is displayed.
- **Holder Details**: Displays a description of the Sample holder selected in the Sample Holder field.

Figure 5.16 Warning dialog shown when whole plate login is attempted under the single page login
Sample Details

The fields in this section are dependent on the method file selected see page 5-9.

Login

Clicking the Login Button brings up the following dialog (Figure 5.17).

![Figure 5.17 The Sample Login dialog](image)

Figure 5.17 The Sample Login dialog

Figure 5.17 tells the user where to place samples. Pressing OK or cancel returns the user back to the single page login dialog. If all the necessary fields are not filled in then the user is prompted with the warning dialog shown in Figure 5.18.

![Figure 5.18 Missing Fields Warning dialog](image)

Figure 5.18 Missing Fields Warning dialog

Timeout

To prevent a user from logging on and then leaving the screen partially complete the Login dialog has a timeout. Data must be entered within 300 seconds (5 mins), if it is not the Login will be cancelled and the display will return to the Login screen.

To Change the Timeout

1. Press the Start button and select the Run option.
2. Type in regedit and press the OK button.
3. Double click on the HKEY_CURRENT_USER folder.
4. Double click on the **Software** folder.

5. Double click on the **Micromass** folder.

6. Double click on the **OpenLynx** folder.

7. Double click on the **Login** folder.

8. Double click on the **Login Timeout** icon to display the Edit Value dialog.

9. Select the **Decimal** option, enter the required Timeout value (in seconds) and press the **OK** button.

To disable the timeout feature set the value to 0.
Chapter 6 Registry Settings
Contents

Introduction ........................................................................................................................................... 6-3
Initial Settings ..................................................................................................................................... 6-3
    OpenLynx Browser ......................................................................................................................... 6-3
    OpenLynx ....................................................................................................................................... 6-3
To Edit a Registry Setting ................................................................................................................... 6-4
The Initial Registry Settings ............................................................................................................... 6-5
    OpenLynx ....................................................................................................................................... 6-5
    Batch Manager .............................................................................................................................. 6-5
    Login ............................................................................................................................................. 6-5

Figures

Figure 6.1 The Edit String dialog...................................................................................................... 6-4
**Introduction**

This chapter describes the OpenLynx Registry Settings and how to save, edit and restore them.

**Note:** The Registry Settings should only be amended by the System Administrator.

Settings can be saved and restored at any time. It is advisable to take a copy of the initial settings so that the original setup can be restored without having to re-install the software.

**Initial Settings**

**OpenLynx Browser**

The OpenLynx Browser does not have any initial registry settings, so if the settings become corrupted you can delete them and start again.

**To delete the Browser Registry Settings**

1. Press the **Start** button and select the **Run** option.
2. Type in `regedit` and press the **OK** button.
3. Double click on the **HKEY_CURRENT_USER** folder.
4. Double click on the **Software** folder.
5. Double click on the **Micromass** folder.
6. Click, with the right mouse button, on the **Diversity Browser** folder, and select delete from the pop up menu.

**OpenLynx**

Appendix A contains the initial registry settings. If problems occur with the OpenLynx Software check the current settings against these and if they are corrupted restore the initial ones.

The entire Micromass folder can be saved and restored, but this will delete settings for other parts of MassLynx system e.g. Inlet configuration.

**To save the initial Registry Settings**

1. Put a blank disk in drive a:
2. Press the **Start** button and select the **Run** option.
3. Type in `regedit` and press the **OK** button.
4. Double click on the **HKEY_CURRENT_USER** folder.
5. Double click on the **Software** folder.
6. Double click on the **Micromass** folder.
7. Click on the **OpenLynx** folder.
8. Select **Export Registry File** from the **Registry** menu.

9. Select Drive A: from the **Save in** drop down list box, type in the **File name** and press the **Save** button.

To restore the initial Registry Settings

1. Put the disk with the initial settings in drive a:

2. Press the **Start** button and select the **Run** option.

3. Type in **regedit** and press the **OK** button.

4. Double click on the **HKEY_CURRENT_USER** folder.

5. Double click on the **Software** folder.

6. Double click on the **Micromass** folder.

7. Select **Import Registry File** from the **Registry** menu.

8. Select Drive A: from the **Look in** drop down list box, select the required file and press the **Open** button.

9. A message will appear informing you that the settings were successfully entered into the registry.

To Edit a Registry Setting

1. Double click on the or icon, or select the icon and choose **Modify** from the **Edit** menu. This will display the Edit Settings dialog.

![Figure 6.1 The Edit String dialog](image)

2. Enter the new value and press **OK**. Numeric values are displayed as hexadecimal numbers, click the decimal option to display in decimal format.
# The Initial Registry Settings

## OpenLynx

### Batch Manager

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>[value not set]</td>
</tr>
<tr>
<td>ASInjectFile</td>
<td>c:\Inject.tmp</td>
</tr>
<tr>
<td>ASLoginFile</td>
<td>c:\Login.tmp</td>
</tr>
<tr>
<td>BatchDB Status</td>
<td>C:\MassLynx\OpenLynx\BatchDB\Status.ola*</td>
</tr>
<tr>
<td>MaxStatusTries</td>
<td>0x0000000a (10)</td>
</tr>
<tr>
<td>PrintMode</td>
<td>0x00000001 (1)</td>
</tr>
<tr>
<td>Report Engine</td>
<td>C:\MassLynx\DivBtro.exe /p</td>
</tr>
<tr>
<td>ReportDB</td>
<td>C:\MassLynx\OpenLynx\ReportDB*</td>
</tr>
<tr>
<td>RunMode</td>
<td>0x00000028 (129)</td>
</tr>
<tr>
<td>Sample Positions Default</td>
<td>0x00000064 (100)</td>
</tr>
<tr>
<td>StatusWait</td>
<td>&quot;0.100&quot;</td>
</tr>
<tr>
<td>Summary Engine</td>
<td>C:\MassLynx\DivBtro.exe /r</td>
</tr>
<tr>
<td>UseRegAS</td>
<td>0x00000001 (1)</td>
</tr>
</tbody>
</table>

## Login

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>[value not set]</td>
</tr>
<tr>
<td>Allow User Name Creation</td>
<td>0x00000001 (1)</td>
</tr>
<tr>
<td>BatchDB Status</td>
<td>C:\MassLynx\OpenLynx\Batchdb\Status.ola*</td>
</tr>
<tr>
<td>BedReserveWait</td>
<td>&quot;1.100&quot;</td>
</tr>
<tr>
<td>Command Button Text</td>
<td>&quot;Login Samples...&quot;</td>
</tr>
<tr>
<td>Enable Job Name</td>
<td>0x00000001 (1)</td>
</tr>
<tr>
<td>HPLC Description File Location</td>
<td>C:\MassLynx\OpenLynx\BatchDB*</td>
</tr>
<tr>
<td>Login Timeout</td>
<td>0x00000012c (300)</td>
</tr>
<tr>
<td>MaxResTries</td>
<td>0x0000000a (10)</td>
</tr>
<tr>
<td>MaxStatusTries</td>
<td>0x00000000a (10)</td>
</tr>
<tr>
<td>MethodsDB Search Path</td>
<td>C:\MassLynx\op&quot;</td>
</tr>
<tr>
<td>Next Job Number</td>
<td>0x00000001 (1)</td>
</tr>
<tr>
<td>Number of Batches between QC</td>
<td>0x00000001 (1)</td>
</tr>
<tr>
<td>Number of Probes</td>
<td>0x00000001 (1)</td>
</tr>
<tr>
<td>ProfileFile</td>
<td>C:\OpenLynx_Login\OALLogin.pro</td>
</tr>
<tr>
<td>QC Job Number</td>
<td>0x00000001 (1)</td>
</tr>
<tr>
<td>RestAckWait</td>
<td>&quot;0.100&quot;</td>
</tr>
<tr>
<td>StatusAckWait</td>
<td>&quot;0.100&quot;</td>
</tr>
<tr>
<td>StatusWait</td>
<td>&quot;0.100&quot;</td>
</tr>
<tr>
<td>TimeQCHour</td>
<td>&quot;0b&quot;</td>
</tr>
<tr>
<td>Title Bar Text</td>
<td>&quot;OpenLynx Login&quot;</td>
</tr>
</tbody>
</table>

*Where the string values begin with C:\MassLynx and C:\OpenLynx_Login, these are the install directories for MassLynx and OpenLynx Login and will depend on where these have been installed.*
Index

Accurate Mass Error Reporting, 2-28
Action on Error, 5-5
Add
   Adduct, 2-17
   Field, 3-11
   Adducts, 2-17
   Add, 2-17
   Delete, 2-18
AFAMM, 2-24
   Parameters, 2-24
Analog Data Page, 2-16
Base File Name, 5-5
Batch File, 1-4
Browser, 3-1
   Menu Options, 3-24
Browser File
   Copy, 3-7
   Open, 3-7
   Print, 3-7
Browser Screen, 3-5
Chromatogram, 2-6, 2-20, 2-28
Chromatogram Page, 3-15
Chromatogram Pane, 3-32
Chromatogram Report Page, 3-10, 3-12
Chromatogram Test Page, 2-28
Chromatographic peak, 2-20
Clear Job Queue, 4-6
Column Heaters, 5-10
Column Pages, 3-20
Combine Parameters, 2-20
Configuration Wizard, 2-5
Configure OpenLynx Setup, 2-5
Copy
   Browser File, 3-7
Correction Parameters, 2-25
DataBase, 2-38
Decimal Places, 3-13
Decimal Places Page, 3-10, 3-13
Default Data, 5-6
Default Data File Name, 5-15
Default Job Identifier, 5-14
Default Plate Page, 3-17
Delete
   Adduct, 2-18
Delimited Files, 5-11
Dialog
   AFAMM Parameters, 2-24
   Field Mapper, 2-11
   Isotopic Cluster Analysis, 2-25
   Library Build Setting, 2-36
   Library Selection, 2-34
   Login, 5-3, 5-7, 5-10
   Login Options, 5-14
   Mass Measure, 2-23
   MaxEnt, 2-23
   Missing Fields Warning, 5-19
Print, 3-7
Print Control, 3-8
QC Options, 5-4
Select View Options, 2-8
Single Page Login, 5-18
Stream Parameters, 2-31
Whole Plate Login Warning, 5-18
Diode Array Data, 5-11
Display Options
   Other, 3-23
Diversity, 2-27
Duplicate Sample, 2-39
Electrospray Spectra, 2-22
Elemental Columns Page, 3-20
Elemental Composition, 2-36
Elemental Report, 3-10
E-mail, 5-15
E-mail User, 5-6
E-mailing Reports, 4-7
Field Alias, 3-11
Field Mapper Dialog, 2-11
Field Width, 3-11
FIFO, 1-3
Flow Rate, 5-10
Fraction Columns Page, 3-20
Fraction Display Page, 3-21
Fraction Results List Pane, 3-28
Fraction Results Summary Page, 3-10
Full Spectrum Scan, 2-37
Global Server, 2-38
Gradient, 5-10
Gradient Parameters, 5-10
Header Page
   Report, 3-12
   Sample, 3-12
HP1100, 5-9
HPLC, 5-9
   Column Heaters, 5-10
   Flow Rate, 5-10
   gradient, 5-15
   Gradient, 5-10
   Gradient Parameters, 5-10
   Injection Volume, 5-10
   Isocratic Mode, 5-10
   Pump, 5-15
   Run Time, 5-10
HPLC File Location, 5-13
HPLC Pump, 5-15
   Injection Volume, 5-10
   Input Fields, 2-11
   Installation, 1-5
   Installing the Browser, 1-8
   Isocratic Mode, 5-10
   Isotope Modelling, 2-22
   Isotopic Cluster Analysis, 2-25
   Mass 1, 2-26
Mass 2, 2-26
Job Number, 5-5
Library
    Build, 2-36
    Search, 2-34
    Select, 2-33
Library Build Setting Dialog, 2-36
Library Columns Page, 3-20
Library Page, 2-33
Library Search Results, 3-32
Library Selection Dialog, 2-34
Life Cycle of a Sample, 1-4
Lines, 3-22
List Columns Page, 3-20
Load on Startup, 3-24
Login Screen, 5-15
LoginPC, 1-3
Mass, 5-6
Mass 1, 2-26
Mass 2, 2-26
Mass Measure Dialog, 2-23
Mass Measure MS Data, 2-23
MaxEnt, 2-22
Menu
    View, 3-25
    Window, 3-26
Menu Options, 3-24
Micro Titre Plate Login, 1-5
Mode
    Wizard, 5-17
    Modes of Operation, 1-5
MS Data Page, 2-13
MSPC, 1-3
Multi-probe Capability, 2-30
MUX, 2-30
Network Connections, 1-6
Noise, 2-27
OAQuantify, 2-40
Open
    Browser File, 3-7
    Report Schemes, 3-8
OpenLynx
    Parameter File
        Open, 2-9
OpenLynx Browser, 3-1
    View Options, 3-13
OpenLynx Global Server, 2-38, 4-4
OpenLynx Login, 5-1
    File Menu, 5-12
    Method Files, 5-12
    Status Bar, 5-3
    Status File, 5-13
OpenLynx Login Dialog, 5-3
OpenLynx Manager, 4-1
    Administration Menu, 4-5
    File Menu, 4-4
OpenLynx Parameter File
    Create, 2-9
    Print, 2-9
OpenLynx Setup, 2-1
OpenLynx Setup File, 5-5
Options, 5-14
Oracle, 2-38
Oracle Database, 2-38
Overload
    Maximum Intensity, 2-27
Page
    Analog Data, 2-16
    Decimal Places, 3-13
    Library, 2-33
    MS Data, 2-13
    OAQuantify, 2-40
    Print Control, 3-9
    Printing, 2-12
    Quality Control, 2-29
    Quantify, 2-32
    Spectrum Test, 2-27
    Peak Density, 2-27
    Peak Filter Parameters, 2-24
    Peak Match, 2-25
    Peak Separation, 2-20
    Plate Login, 4-6, 5-6, 5-7
    Plate Pane, 3-26
Print
    Browser File, 3-7
    Print Control Dialog, 3-8
    Print Control Page, 3-9
    Print Report Format, 4-5
    PrintDialog, 3-7
    Printing Page, 2-12
    Probes, 5-5
    QC, 2-30
    QC Sample Every, 5-5
    QC Setup, 5-4
    Quality Control Page, 2-29
    Quantify Page, 2-32
    Registry Settings, 6-1
    Restoring, 6-4
Remove
    Field, 3-11
    Report Files, 3-5
    Report Header Page, 3-10, 3-12
    Report Location, 4-4
    Report Scheme
        Settings, 3-8
    Report Schemes, 3-8
        Open, 3-8
        Save, 3-8
    Reprocessing Samples, 1-4
    Reset Login Position, 5-6
    Results Pane, 3-31
    Results Summary Page, 3-10, 3-12
    Results Table Pane, 3-28
    Run Time, 5-10
    Sample Description Pane, 3-27
    Sample Details, 5-19
    Sample Header Page, 3-10, 3-12
    Sample Holder, 5-18
Sample Login, 5-6
Sample Summary Page, 3-10
Save
  Report Schemes, 3-8
Search Library, 2-34
Select Library, 2-33
Select View Options Dialog, 2-8
Set Bed Layout, 4-5
Set Job Number, 5-6
Setup
  Develop OpenLynx methods, 2-5
SID, 2-38
Single Sample File Login, 5-16
Single Sample LC, 1-5
Single Sample Loop, 1-5
Single Shot login, 5-6
Sort Methods, 5-16
Spectrum Page, 3-13
Spectrum Pane, 3-30
Spectrum Report Page, 3-10
Spectrum Search Report Page, 3-10
Spectrum Test Page, 2-27
Spreadsheets, 5-12
Stream Parameters Dialog, 2-31
Swap List View, 3-25
Swap Mode, 5-16
Text Editor, 5-12
Threshold Spectra, 2-19
Timed QC, 5-5
Timeout, 5-19
Toolbar
  OpenLynx Browser, 3-6
  Setup, 2-8
User Factor, 2-33
User Interface, 2-6
  Selecting Tabs to Display, 2-7
User Name, 5-5
Username, 5-15
Vial Position, 5-6
View Menu, 3-25
View Options
  Chromatogram Page, 3-15
  Column Pages, 3-20
  Default Plate Page, 3-17
  Fraction Display Page, 3-21
Waters 2690, 5-9
Window Menu, 3-26
Wizard, 5-17